Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
RCP-QE18, RCP-QE36 User Guide

- Ross Part Number: 2201DR-903-04
- Release Date: July 24, 2018.

The information contained in this Guide is subject to change without notice or obligation.

Copyright

©2018 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Statement of Compliance

This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that compliance information is needed in request.

EMC Notices

United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.
Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재) (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다. This equipment is Industrial (Class A) electromagnetic wave suitability equipment and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Warranty and Repair Policy

The product is backed by a comprehensive one-year warranty on all components.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross. Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information, contact your regional sales manager.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.
To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your area. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
# Contents

## Introduction
- Related Publications ................................................................. 11
- Documentation Conventions .................................................... 12
- Contacting Technical Support .................................................... 12

## Hardware Overview
- Front Panel Overview ............................................................. 13
- Rear Panel Overview ............................................................... 15
- Physical Dimensions ............................................................... 15

## Getting Started
- Features ..................................................................................... 17
- Typical System Equipment ....................................................... 17
- System Overview ....................................................................... 18
- How the RCP-QE and Routing Switchers Communicate .............. 18
- Installation and Configuration Overview ................................. 19
- Physical Installation .................................................................. 20
- Basic Configuration ................................................................... 21
- Adding the RCP-QE to the DashBoard Tree View ..................... 23
- Setting up the Routing Mode ................................................. 26
- Resetting Devices ..................................................................... 26

## Destination and Sources
- Specifying the Number of Outputs/Inputs ............................... 27
- Assigning Output and Input Labels ......................................... 27
- Assigning a Destination to a Button ....................................... 28
- Assigning a Source to a Button ............................................... 29
- Assigning a Crosspoint Button .............................................. 29
- Setting the Retry Time for Communications .......................... 30
- Making a Switch ....................................................................... 30
- Switching with a Crosspoint .................................................. 32
- Toggling Between Two Sources ............................................. 32

## Breakaways and Levels
- What is a Breakaway? ............................................................. 35
- Before You Begin ...................................................................... 35
- Setting up the Breakaways ..................................................... 35
- Automatically Resetting a Custom Breakaway to the Default After a Switch ....................................................... 36
- Assigning a Breakaway Button .............................................. 37
- Assigning a Breakaway Step Button ..................................... 37
- Assigning a Level Button ....................................................... 38
- Selecting Breakaways and Levels .......................................... 38
- Viewing the Breakaways Assigned to an RCP-QE .................. 39
- Level Mask Mode .................................................................... 40

## Menus
- Setting Up Menus ................................................................. 43
- Navigating the Menus ........................................................... 44
- Returning to the Home Menu ............................................... 45
Functions 47
What is a Function? .........................................................................................................................................................47
Assigning a Function to an LCD Button .......................................................................................................................47
Assigning a TAKE Button ................................................................................................................................................48
Assigning a Chop Button ................................................................................................................................................48
Clearing a Function from a Button ................................................................................................................................49
Configuring the Function Buttons on the RCP-QE ........................................................................................................49

Macros 51
What is a macro?.............................................................................................................................................................51
Assigning a Macro Button ...............................................................................................................................................51
Recording a Macro Using the Panel ................................................................................................................................51
Editing a Macro Using the Panel ....................................................................................................................................51
Configuring a Macro using DashBoard .........................................................................................................................52
Assigning a Name to a Macro using DashBoard ........................................................................................................53
Using a Macro ...............................................................................................................................................................53

Salvos 55
What is a salvo?...............................................................................................................................................................55
Assigning a Salvo to a Button .........................................................................................................................................55
Using a Salvo ..................................................................................................................................................................55

Category Modes 57
Category Mode Setup on the RCP-QE ............................................................................................................................57
Using Group Category Mode ........................................................................................................................................58
Using Category/Index Mode .........................................................................................................................................60
Using Legacy Category Mode .......................................................................................................................................62
Using a Level Mask with Category Mode ......................................................................................................................63

Protects and Locks 65
What is a Protect?............................................................................................................................................................65
What is a Panel Lock?.......................................................................................................................................................65
Assigning a Protect Button .............................................................................................................................................65
Assigning a Panel Lock Button .....................................................................................................................................66
Locking a Panel from DashBoard ................................................................................................................................66
Locking the RCP-QE .........................................................................................................................................................67
Protecting a Destination ................................................................................................................................................67
Clearing Protects Held by an RCP-QE ............................................................................................................................68

Machine Control 69
What is Machine Control? ..............................................................................................................................................69
Setting Up Machine Control ..........................................................................................................................................69
Assigning a Machine Control Button .............................................................................................................................70
Configuring a De-assign Button ...................................................................................................................................70
Using a De-assign Button ...............................................................................................................................................70
Operating Linked Remote Control Panels ....................................................................................................................71

Managing Panel Configurations 73
Saving the Current Configuration for the RCP-QE .........................................................................................................73
Editing a Configuration File ............................................................................................................................................74
Sending a Configuration File to a Device .......................................................................................................................74
Loading the Factory Defaults Using DashBoard ........................................................................................................74
## Monitoring

- Configuring the Button Display Options on the RCP-QE .......................................................... 77
- Assigning a Display Status Function to a Button .......................................................................... 78
- Viewing Status and Alarms in the DashBoard Tree View ............................................................. 78
- Troubleshooting .............................................................................................................................. 79
- Upgrading the Software .................................................................................................................. 80

## DashBoard Interface Overview

- RCP-QE Connection Editor Fields ............................................................................................... 81
- RCP-QE Panel Config Interface .................................................................................................... 83

## Panel Hexadecimal to Router Level Conversion

- ................................................................................................................................................... 101

## Glossary

- .................................................................................................................................................... 103
Introduction

This guide is for installers and operators of the Ross Video RCP-QE18 and RCP-QE36. It provides instructions on how to connect the panel to your routing switcher system, how to set up a configuration file for the RCP-QE using DashBoard, and how to operate the RCP-QE. It assumes that you are experienced with general broadcast concepts and that you are familiar with the planning requirements for a routing switcher system. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Hardware Overview” provides a summary of the components on the panel chassis.
• “Getting Started” provides an overview for creating a routing system with RCP-QE, instructions for the installation of the RCP-QE panel, and how to establish initial communications with the routing system.
• “Destination and Sources” provides instructions for specifying the number of outputs/inputs, configuring labels, assigning sources and destinations to buttons, and making switches.
• “Breakaways and Levels” provides instructions for using breakaways and levels.
• “Menus” enables you to define and use the panel menus available to assign to buttons.
• “Functions” defines what a function is, how to assign a function to the buttons on the hard panel.
• “Macros” provides instructions for creating and editing macros, assigning a macro to a button, and using macros via the hard panel.
• “Salvos” provides instructions to assigning a salvo to a button and how the RCP-QE uses salvos.
• “Category Modes” provides instructions for assigning a Category Index mode to a button, and using Category Index mode on the RCP-QE.
• “Protects and Locks” defines when to use a protect and lock, configuring a Protect or Lock button, how to protect a destination, and how to clear protects held by a remote control panel.
• “Machine Control” provides instructions on how to set up machine control on the RCP-QE, assigning a MC Key button, configuring and using a De-assign button. A general summary of operating linked remote control panels is also provided.
• “Managing Panel Configurations” teaches you how to create, edit, and save configuration files for your remote control panels, and how to update the button mapping and menus on your hard panel.
• “Monitoring” provides information on the display options for the buttons, how to monitor the panel via DashBoard, general tips to troubleshoot common problems, and briefly summarizes the steps required to update the firmware on the hard panel.
• “DashBoard Interface Overview” briefly summarizes the RCP-QE interfaces, tabs, menus, and parameters available in DashBoard.
• “Panel Hexadecimal to Router Level Conversion” provides a look-up table when using hexadecimal characters for router levels.
• “Glossary” provides definitions of commonly used terms and conventions for this guide.

If you have questions pertaining to the operation of your RCP-QE, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your RCP-QE:

• Acuity and Auxiliary Control Panels Setup Sheet, Ross Part Number: 4820DR-677
• DashBoard User Manual, Ross Part Number: 8351DR-004
• NK-IPS User Guide, Ross Part Number: 9807DR-1020
• NK-NET User Guide, Ross Part Number: 2201DR-002
Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the **Edit** dialog, click **Insert Above**.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the **Language** box, enter **English**.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the *NK-IPS User Guide*.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads “**File** > **Save As**,” you would click the **File** menu and then click **Save As**.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: http://www.rossvideo.com
Hardware Overview

This chapter summarizes the hardware features of the RCP-QE front and rear panels.

Front Panel Overview

The number of buttons on the RCP-QE front panel depends on the model.

1. Function Buttons

This area of eight non-LCD buttons come standard on each RCP-QE. You can assign functions to these buttons as outlined in the section “Configuring the Function Buttons on the RCP-QE” on page 37. Figure 2.3 illustrates the default button numbering. The numbering is the same regardless of the panel model.

Table 2.1 lists the default function and color scheme for each Function button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Default Function</th>
<th>Default Color</th>
<th>Selected Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HOME</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>2</td>
<td>UP MENU</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>3</td>
<td>Unassigned</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>4</td>
<td>TAKE</td>
<td>Off</td>
<td>Red</td>
</tr>
<tr>
<td>5</td>
<td>Category Mode</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>6</td>
<td>DOWN MENU</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>7</td>
<td>Unassigned</td>
<td>Off</td>
<td>Ultricore Blue</td>
</tr>
<tr>
<td>8</td>
<td>PROTECT</td>
<td>Off</td>
<td>Orange</td>
</tr>
</tbody>
</table>
Menu navigation functions do not light their selected LED colors when pressed.

2. LCD Buttons

There are two sizes in the RCP-QE family: RCP-QE18 and RCP-QE36. The RCP-QE18 provides 18 LCD buttons in a single bus, while the RCP-QE36 provides 36 LCD buttons (2 buses of 18 buttons each). These buttons (keys) typically are assigned as sources or destinations. However, you can assign any function to them.

By default, the 18 buttons on the RCP-QE18 are assigned the following functions (from left to right):

- buttons 1 to 9: destinations (outputs 1 to 9, respectively)
- buttons 7 to 18: sources (inputs 1 to 9, respectively)

By default, the 36 buttons on the RCP-QE36 are assigned the following functions (from left to right):

- buttons 1 to 18: sources (inputs 1 to 18, respectively)
- buttons 19 to 36: destinations (outputs 1 to 18, respectively)

LCD Buttons Overview

The LCD buttons reflect any one of the following, depending on their current use:

- current status
- label
- current display mode
- special indicators

The text on the button changes as required. The color and inverse settings change depending upon the status of the button and how these display options have been set up. The default status shows when the button is not selected. The selected status shows when the button is selected.

The special indicators for the LCD buttons are as follows:

<table>
<thead>
<tr>
<th>Button Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI</td>
<td>Breakaway step indicator (breakaway step button).</td>
</tr>
<tr>
<td>VTR1</td>
<td>This status is not true for all levels (breakaway warning).</td>
</tr>
<tr>
<td>CAM2</td>
<td>Crosspoint indicator (crosspoint button) or a crosspoint layer indicator (crosspoint layer button).</td>
</tr>
<tr>
<td>VTR1</td>
<td>The destination is protected by this RCP-QE panel.</td>
</tr>
<tr>
<td>VTR1</td>
<td>This destination is protected by another remote control panel.</td>
</tr>
</tbody>
</table>
For More Information on...
• the button display options, refer to “Configuring the Button Display Options on the RCP-QE” on page 77.

Rear Panel Overview

Each rear panel provides a power supply connection and an ethernet port. The features of the rear panel is the same regardless of the panel model.

1. PSU Connection

There is one power supply connector located on the rear of each RCP-QE. This connector requires a 5VDC connection to an external power supply.

Notice — The RCP-QE automatically powers on when power is applied.

2. Ethernet Port

The Ethernet port is an RJ45 connector used to connect the panel to an external Ethernet network. This port has its RJ45 connector wired as a Network Interface Card (NIC).

Notice — The Ethernet port does not provide Power-over-Ethernet (PoE).

An ethernet connection is required to bridge the external Ethernet network to the local communications bus for monitoring and control of the panel.

Physical Dimensions

<table>
<thead>
<tr>
<th>Item</th>
<th>RCP-QE18</th>
<th>RCP-QE36</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>19” (48cm)</td>
<td>19” (48cm)</td>
</tr>
<tr>
<td>Depth</td>
<td>2.5” (6cm)</td>
<td>2.5” (6cm)</td>
</tr>
<tr>
<td>Height</td>
<td>2.0” (4.3cm)</td>
<td>2.0” (4.3cm)</td>
</tr>
<tr>
<td>Weight (approx.)</td>
<td>2.4lb (1.1kg)</td>
<td>2.8lb (1.25kg)</td>
</tr>
</tbody>
</table>
Getting Started

Thank you for purchasing a Ross Video RCP-QE series Remote Control Panel. This remote control panel enables you to control a routing switcher system from one point. With Ross Video’s reputation for delivering leading-edge routing switcher equipment and our unsurpassed level of customer service and support, you can look forward to many years of reliable broadcasting. Please read this thoroughly and retain it for future reference.

Each RCP-QE series panel provides flexible connectivity of additional remote control panels and multi-page menu programming.

Features

The RCP-QE is used when you require advanced control functions from a single point. Using DashBoard, you can program up to 250 menus on the same remote control panel. On each menu, the function of particular buttons may change depending on the assignment. These parameters can be saved in a configuration file and sent to an RCP-QE at any time using DashBoard. Therefore, if an RCP-QE is used in a number of different operating scenarios, the configuration can be changed easily and quickly.

The RCP-QE provides the following features:

- 18 or 36 programmable buttons depending on the panel model
- additional 8 programmable Function buttons
- operation in XY mode
- up to 32 router levels may be controlled
- virtual routing and resource management
- macros
- custom module in DashBoard for easy creation of configuration files
- firmware is fully upgradeable using DashBoard
- slim modular design integrates with NK Series devices via NK-NET Ethernet to T-BUS bridge
- up to 250 pages of programmable menus including navigation buttons
- assignable functions of destination, source, crosspoint, level, breakaway, breakaway step, macro, salvo, Category Index Navigation, protect, take, chop, de-assign, machine control, panel lock, menu link, menu navigation, and menu display.

Category Index Navigation and salvos require the RCP-QE to communicate with an Ultrix router or Ultricore Central Controller.

Typical System Equipment

Typical equipment that is used in a Ross routing switcher system when an RCP-QE is used includes:

- a standard Ethernet 10/100/1000 network with an available range of addresses for fixed IPv4 addressing
- any of the NK Series routing switchers with its appropriate power supply (for more information see the documentation provided with your NK Series routing switcher)
- an NK-NET, NK-IPS, Ultrix router, or Ultricore Central Controller
- a computer running DashBoard, connected via a standard CAT5/5e/6 Ethernet cable to the network
- signal source and destination equipment (for example, cameras, VTRs, servers)
System Overview

A routing switcher system may use distributed control across the internet, a LAN, or a VPN. The routing switcher system shown in Figure 3.1 has been simplified.

How the RCP-QE and Routing Switchers Communicate

The RCP-QE communicates with Ross routing systems via standard 10/100/1000 Ethernet network. A range of fixed addresses (IPv4) should be made available for all the ethernet connected devices with the routing system.

The RCP-QE sends a switch request message, and receives acknowledgments and status updates, via Ethernet to the configured routing system server IP address device.

* The RCP-QE requires TCP port 5000 for DashBoard and switching communications, and port 15000 for Ultricore database communication (if used).

Data Storage

The RCP-QE stores information on the menu, destination, level, breakaway, and machine control status. The routing switcher stores the crosspoint status in its internal memory.
When the routing switcher system is powered up, the routing switcher restores its crosspoint status. Upon selecting a destination button, the RCP-QE requests the status of the routing switcher. The routing switcher sends the status of the destination to the RCP-QE.

Installation and Configuration Overview

The generalized workflow of setting up your RCP-QE is:
1. Implement your routing system plan.
2. Physically install the RCP-QE.
   ♦ Contact your IT department before connecting to your facility network to ensure that there are no conflicts.
3. Configure the network settings for the RCP-QE.
4. Ensure that DashBoard discovers the RCP-QE on your network.
5. Specify the routing mode (virtual or physical).
6. Configure the button layout for your RCP-QE.

Implementing Your System Plan

An effective routing system takes careful planning. If you intend to use multiple router levels across several input and output devices, it is recommended that you use common input connectors for each source device across the routing switchers and common output connectors for each destination device across the routing switchers. This methodology is shown in Figure 3.2. The following process for setting up the RCP-QE is recommended.

![Flow Chart for Setting up the RCP-QE](image-url)

Figure 3.2 Flow Chart for Setting up the RCP-QE
Physical Installation

* We recommend that the equipment is installed to any relevant standards and approvals by qualified and experienced personnel.

Unpacking the Equipment

On receiving your RCP-QE, check the contents against the packing list. Before you start installing the RCP-QE into your system, ensure that all equipment itemized on the packing list is present and that there are no signs of damage.

If anything is missing or damaged, contact your Ross Video office immediately to obtain the correct warranty service procedures. This ensures prompt assistance, minimal turnaround time, and avoids any freight issues.

Before You Begin

These installation guidelines assume the following:

- The relevant Ross equipment has been installed into a ventilated rack frame. The relative humidity in the environment of the equipment should be < 70% (non-condensing).
- The routing switcher system has been well planned and designed. Consideration must be given to inputs and outputs across multiple router levels and typical operating scenarios for breakaways.
- Where required, correct IP addresses have been assigned to the equipment.
- The routing switchers are connected to physical inputs and outputs and have appropriate power supplies.

Installing the RCP-QE

The RCP-QE uses a TCP network for connection. It connects to the T-BUS routing devices using either the NK-NET or the NK-IPS. The NK-NET receives phantom power from the T-BUS devices to which it is connected. If the device providing power loses power, the NK-NET loses power as well.

Figure 3.3 Example of an RCP-QE Connected within an NK Routing System
Connecting to a Routing System

The RCP-QE is designed for installation into a standard 19” equipment rack. It has integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

To connect the remote control panel in the routing system

1. Place the RCP-QE into the rack frame and then fix in place with appropriate fasteners.
2. Connect a standard CAT5/5e/6 Ethernet cable to the ETHERNET connector on the rear of the RCP-QE.
3. Connect the other end of the standard CAT5/5e/6 Ethernet cable to the network TCP switch/hub.

Connecting to a Power Source

The RCP-QE is powered using the 5V 2A power supply provided. This power supply connects directly to the AC mains supply.

---

**Warning** — Ensure that the AC mains supply complies with the PSU specification before making the connection.

**Warning** — An earthed neutral mains supply and residual current device is recommended for safe operation.

To connect the remote control panel to a power source

1. Connect the 5V 2A power supply provided to the POWER connector on the rear of the RCP-QE.
2. Connect the cable from the power supply to a suitable AC mains supply.

Basic Configuration

Keep the following in mind before proceeding with the basic configuration of your panel:

- The DashBoard client software allows configuration and monitoring of the RCP-QE via a computer connected to the same network as your routing system.
- DashBoard must be run on a computer that has a physical wired ethernet connection. Wireless connections do not allow device discovery.
- You must have an NK-NET, NK-IPS, or Ultricore Central Controller connected to the T-BUS system to connect to NK Series devices.
- The RCP-QE can be added to DashBoard via automatic discovery or manually using the NK-IPS Connection window. Both methods are described below.
- The DashBoard client software can be downloaded from http://www.rossvideo.com/.

Using DashBoard

When the RCP-QE is attached to the network, it is interrogated and its configuration interfaces are made available in the DashBoard window. The RCP-QE interfaces are accessed by expanding the RCP-QE node in the DashBoard Tree View and selecting the appropriate sub-node.

You cannot access the RCP-QE interfaces until the RCP-QE displays in the Tree View in DashBoard. Refer to the sections “Adding the RCP-QE to the DashBoard Tree View” on page 23.

There are two main RCP-QE interfaces in DashBoard: Connection Editor and the Panel Config. Each interface is represented as a sub-node under the main RCP-QE node.
To launch DashBoard
1. Verify that you have installed the DashBoard client software version 8.2 or higher on a PC connected to the same network as your routing system.
2. Launch DashBoard by double-clicking its icon on your PC desktop.

Accessing the RCP-QE Connection Editor
The RCP-QE Connection Editor takes the panel’s configured name and sets the connections to the routing system.

For More Information on...
• the RCP-QE Connection Editor menus, refer to the section “RCP-QE Connection Editor Fields” on page 81.

To open the RCP-QE Connection Editor
1. Launch DashBoard as outlined in the procedure “To launch DashBoard” on page 22.
2. Locate the RCP-QE in the Tree View of DashBoard.
3. Expand the RCP-QE node to display a list of sub-nodes in the Tree View.
4. Double-click the Connection icon (the second sub-node) within the tree.

The Connection Editor opens.

Accessing the RCP-QE Panel Config Interface
The RCP-QE Panel Config interface enables users to configure the panel buttons to suit your requirements.

For More Information on...
• the RCP-QE Panel Config interface menus, refer to the section “RCP-QE Panel Config Interface” on page 83.
To open the RCP-QE Panel Config interface
1. Launch DashBoard as outlined in the procedure “To launch DashBoard” on page 22.
2. Locate the RCP-QE in the Tree View of DashBoard.
3. Expand the RCP-QE node to display a list of sub-nodes in the Tree View.
4. Double-click the Panel Config icon (the first sub-node) within the tree.
   The Panel Config interface opens.

Adding the RCP-QE to the DashBoard Tree View
In order to access the RCP-QE in DashBoard and configure its settings, the RCP-QE needs to be detected and the IP address for the LAN configured for use within a network using Walkabout. Once the network settings are configured in Walkabout, the RCP-QE is visible in DashBoard and you can update the panel device details, button assignments, and a configuration file sent to it.

Ensure that DashBoard has all the latest module updates before proceeding.

For More Information on...
• checking and upgrading firmware, see “Checking the Firmware Version” on page 63 and “Upgrading the Firmware Version” on page 63.
• saving parameters to a configuration file, see “Saving the Current Configuration for the RCP-QE” on page 73.
• installing and using DashBoard, refer to the DashBoard User Manual.

Adding an RCP-QE to DashBoard via Automatic Discovery
The RCP-QE can be detected in DashBoard using auto discovery via SLP once the IP address for the LAN has been configured for use within a network using Walkabout.

To add an RCP-QE to the Tree View in DashBoard
1. Launch DashBoard.
2. From the DashBoard client main toolbar, select File > Show Walkabout.
   The DashBoard window displays the Walkabout table.
3. Click Refresh to query the network for RCP-QE devices.
4. In the **Walkabout** table, locate the RCP-QE you want to add to DashBoard.

5. Configure the following information if necessary:
   - **Name** – double-click inside the cell to enter a name for the RCP-QE. The default is RCP-QE.
   - **Address** – double-click inside the cell to enter an IP address for the RCP-QE. The default is 192.168.20.130.
   - **Netmask** – double-click inside the cell to enter an IP netmask for the RCP-QE. The default is 255.255.255.0.
   - **Gateway** – double-click inside the cell to enter an IP gateway for the RCP-QE. The default is 192.168.20.1.

6. Refresh the **Basic Tree View**.
   The RCP-QE is added to the devices listed in the **Basic Tree View**.

### Manually Adding an RCP-QE to DashBoard

RCP-QE can be added manually to DashBoard by entering its IP address using the NK-IPS Connection window once it has been configured for use within a network using Walkabout.

**To manually add an RCP-QE to DashBoard**

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select **File > Show Walkabout**.
   The DashBoard window displays the **Walkabout** table.

3. Click **Refresh** to query the network for RCP-QE devices.

4. Locate the RCP-QE you want to add to DashBoard and configure the following information if necessary:
   - **Name** – double-click inside the cell to enter a name for the RCP-QE. The default is RCP-QE.
   - **Address** – double-click inside the cell to enter an IP address for the RCP-QE. The default is 192.168.20.130.
   - **Netmask** – double-click inside the cell to enter an IP netmask for the RCP-QE. The default is 255.255.255.0.
   - **Gateway** – double-click inside the cell to enter an IP gateway for the RCP-QE. The default is 192.168.20.1.

5. In **DashBoard**, click **File > New > NK-IPS Connection**.
   The **NK-IPS Connection** window opens.

   ![NK-IPS Connection window](image)

6. In the **IP Address** box, enter the IP address of the RCP-QE you want to add to DashBoard.

7. Use the **Port** list to select a port number. The default is 5000.

   ![Port list](image)

   * If the port number is changed in Walkabout, the port number in the NK-IPS Connection window must be configured to reflect this change.

8. Click **Finish**.
The NK-IPS Connection window closes and the RCP-QE is added to the devices listed in the Basic Tree View in the DashBoard window.

Connecting to the Routing System

Once you have established communication between the DashBoard client and the RCP-QE, you will need to connect the panel to the routing system. You can specify multiple devices for the RCP-QE to communicate with, but the panel will only connect to one device at a time (as indicated by the read-only Connected check box beside the IP Address for the device). The RCP-QE will attempt to connect to the first device listed in the table, and move to the next device in the table if communication could not be established.

For More Information on...

• establishing communications with an Acuity production switcher, refer to the Acuity and Auxiliary Control Panels Setup Sheet.

To connect the RCP-QE to the routing system

1. Display the Connection Editor as outlined in the procedure “To open the RCP-QE Connection Editor” on page 27.
2. Locate the Servers to Connect to table.
3. In the first row of the table, use the IP Address column to specify the IP Address of the NK-NET, NK-IPS, Ultrix router, or Ultricore Central Controller that the RCP-QE will communicate with.
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Changing the Device Details

Once the RCP-QE is added to the Tree View in DashBoard, you can update the panel details, such as the name it displays in the tree view, assign it to a group in your routing system, and provide additional identification details.

To change the details for the RCP-QE

1. Display the Connection Editor as outlined in the procedure “To open the RCP-QE Connection Editor” on page 27.
2. Locate the Device Details area in the top-right corner of the interface.
3. In the Device Details area, click inside the field that you want to change.
4. Enter the information as required.
5. Press Enter.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

You should save the current configuration file regularly (see “Saving the Current Configuration for the RCP-QE” on page 73).

Default Configuration

Every panel leaves the factory with a default configuration. This default configuration is viewed by opening the editor tab for the device in DashBoard. The parameters for the default configuration are stored within the RCP-QE.

The default configuration may be loaded at any time you wish to return to the factory settings. Refer to the section “Loading the Factory Defaults Using DashBoard” on page 74 for more information.
Setting up the Routing Mode

The RCP-QE can be configured for one of two routing modes:

- **Physical mode** — the input (or output) label 1 refers to input socket #1 on the rear of a physical router. Input label #2 refers directly to input socket #2 and so on. The label number or row, maps directly to the input or output physical connection number of a router.

- **Logical (or virtual) routing mode** — the input (or output) label 1 may refer to one or more physical inputs (or outputs). These inputs can be any of the physical router inputs; the label number or row does not relate one-to-one with the physical inputs and outputs of the router. A 'map' in the control system relates a source or destination label with one or more physical inputs or outputs.

An NK series routing system without an NK-VRC can only use physical mode. The switch commands from the RCP-QE are dealt with directly by the NK routers themselves.

An Ultricore Series system or an NK system with NK-VRC uses virtual (logical) routing and 'Virtual Routing' must be enabled for the RCP-QE to function in these setups. The switch command from the RCP-QE is interpreted by the source and destination maps held within the Ultricore control system active database or the NK-VRC device. Once the logical source or destination has been received from the RCP-QE, the control system queries the map to ascertain the physical router connections involved in the switch command, then forward the physical switch commands to the router/s for execution.

Additionally, resource management may be implemented on the NK-VRC to manage routing of different signal types between one or more routers using external resources. If using resource management, assigning a de-assign to a button will allow the user to park the resource inputs and outputs and de-allocate the resource to be used in other routes.

**For More Information on...**
- setting up and using an NK-VRC see the *NK-VRC Virtual Routing Core User Guide*.

**To enable logical (virtual) routing**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration section, select the Virtual Routing Enabled check box. (You may need to scroll to the bottom of the tab to view this check box.)
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

**Resetting Devices**

To return the RCP-QE to a known operating state and configuration, perform one of the following:

- send a saved configuration to the RCP-QE (see “Sending a Configuration File to a Device” on page 43)
- reset the RCP-QE
- reload the factory defaults on the RCP-QE

If the RCP-QE fails to accept any configuration files that are sent to it, then you should reset the device. When you perform a reset, the RCP-QE takes on the last-known operating state and configuration that is stored in memory. If the RCP-QE fails to reset, then reload the factory defaults.

**To reset a device**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Click Reboot.
Destination and Sources

Destination and source buttons map the physical connections on the routing switcher to the RCP-QE. You can provide labels for these physical connections using the Input Assigns and Output Assigns tabs in the Panel Config interface for the RCP-QE.

* If the RCP-QE is connected to an Ultrix router or Ultricore Central Controller, the number of inputs and outputs are defined by the Ultrix/Ultricore setup. Changes to Ultrix or Ultricore will overwrite any manual changes made on the remote control panel.

For More Information on...
• the options in the Input Assigns and Output Assigns tabs, refer to the section “Output/Input Assigns Tab” on page 92.

Specifying the Number of Outputs/Inputs

Depending on the size of the routing switchers connected, you may choose to increase or reduce the number of output and input labels to match the size of the routing switcher if virtual routing is not used. The number can be changed in increments of 8.

To change the number of possible inputs and outputs
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Perform one of the following:
   • To change the number of outputs, select the Output Assigns tab.
   • To change the number of inputs, select the Input Assigns tab.
3. Use the Number of outputs/Number of inputs box to enter or select the number of outputs/inputs to match the requirements of your routing switcher system.
4. Click Update.
5. If you want to transfer this number of outputs/inputs to the other tab, click Copy to Input Assigns/Copy to Output Assigns. The labels are also copied.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning Output and Input Labels

You can edit the label text for each input and output individually. If there are various router levels using this output or input number, the label may be ambiguous if the destination or source is different for those levels.

* You may rearrange the layout of the labels on the buttons when you assign functions to the buttons (see “Configuring the Function Buttons on the RCP-QE” on page 49).

To assign output and input labels
1. Open the RCP-QE Panel Config interface (see “Accessing the RCP-QE Panel Config Interface” on page 28).
2. Perform one of the following:
   • To change the label for an output, select the Output Assigns tab.
   • To change the label for an input, select the Input Assigns tab.
3. Click to highlight the text in the Label column corresponding to the output/input to which the item of destination/source equipment is connected.
4. Enter the name of the item of destination/source equipment.
5. Press **Enter**.
   The name of the item of destination/source equipment appears on the corresponding button on the simulated RCP-QE in DashBoard.

6. Repeat step 1 to 5 until all of the outputs and inputs on the routing switchers have been assigned a label for the connected destination and source equipment.

7. If you want to transfer the labels for the outputs/inputs to the other assigns tab, click **Copy to Input Assigns/Copy to Output Assigns**.
   The number of outputs/inputs is also copied.

8. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

**Assigning a Destination to a Button**

An output label (also known as a destination), can be assigned to any button. This enables the destination to be selected and ready for further routing commands. The destination is selected by pressing the button, but the switch is not made until the required source button is pressed.

**To assign a destination to a button**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the destination or source.
   The **Key** dialog opens.

3. In the **Button** list, select **Destination**.
4. Use the **Value** list to select the physical output that connects to the item of destination equipment.
5. If you have virtual routing enabled in the RCP-QE, the I/O that you enter represents the virtual destination as set up in the NK-VRC Virtual Routing Core.
   The simulated RCP-QE in DashBoard shows the label for the specified output on the selected button. If you have assigned a name to this output using the **Output Assigns** tab, this name appears on the button.
6. Close the **Key** dialog.
7. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
Assigning a Source to a Button

An input label (also known as a source), can be assigned to any button. This enables the configured routing system inputs to be routed to the previously selected destination outputs. A switch occurs when a source button is pressed and the signal is routed to the currently selected destination. For more information, see “Assigning a Destination to a Button” on page 28.

The function of any source button on a menu is changed when a TAKE button is assigned to the menu (see the information below on Take in the Function Key details).

To assign a source to a button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the destination or source.
   The Key dialog opens.
3. In the Button list, select Source.
4. Use the Value list to select the physical input that connects to the item of source equipment.
   If you have virtual routing enabled in the RCP-QE, the I/O that you enter represents the virtual source as set up in the NK-VRC Virtual Routing Core.
   The simulated RCP-QE in DashBoard shows the label for the specified input on the selected button. If you have assigned a name to this input using the Input Assigns tab, this name appears on the button.
5. Close the Key dialog.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a Crosspoint Button

A breakaway, destination, and source assigned to one button. A switch is achieved by pressing the crosspoint button rather than pressing a breakaway button, a destination button, and then a source button.

The function of any crosspoint button on a menu is changed when a TAKE button is assigned to the menu (see the information below on Take in the Function Key details).

When you make a switch, you need to select the level(s) that you are switching using a breakaway or level button, the destination, and then the source. This requires three button presses. To reduce this effort and the potential for error, common switch sequences may be set up in a crosspoint.

You should also assign a menu navigation button on the same menu as a crosspoint button. Set the menu navigation button to XPoint Layer. This button may be used to toggle through the breakaway, destination, and source information in the crosspoint.

To assign a crosspoint to a button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the crosspoint.
   The Key dialog opens.
3. In the Button list, select Crosspoint.
4. In the Output list, select the physical output that connects to the item of destination equipment to which you want to switch.
5. In the Input list, select the physical input that connects to the item of source equipment that provides the required signal.
6. In the Breakaway list, select the breakaway level that you want to use for the switch.
7. Close the Key dialog.
The simulated RCP-QE in DashBoard shows X-PNT on the selected button.

8. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

For More Information on...
- assigning a menu navigation button, refer to “Assigning Menu Navigation to a Button” on page 44.

Setting the Retry Time for Communications

When you make a switch, a switch request is sent from the RCP-QE to the router control system. If the RCP-QE does not receive a response from the routing switcher, the RCP-QE retries the request after the time specified in the Comms Retry Delay Factor field.

Systems require different retry times depending on the transfer of requests and responses between modules.

<table>
<thead>
<tr>
<th>System</th>
<th>Retry Time (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dedicated local network (direct connection to router specified via an NK-NET or NK-IPS)</td>
<td>20</td>
</tr>
<tr>
<td>Dedicated local network with one of the following: NK-VRC Virtual Routing Core, Ultrix router, or Ultricore Central Controller</td>
<td>50 or greater</td>
</tr>
<tr>
<td>Shared local network (non-dedicated general facility)</td>
<td>100</td>
</tr>
<tr>
<td>Remote or VPN connection</td>
<td>250</td>
</tr>
</tbody>
</table>

* If switch performance appears slow and the log shows multiple retry and timeout events, you should increase the retry time.

To set the retry time
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration section, use the Comms Retry Delay Factor box to adjust the retry time (in milliseconds) according to the requirements of your routing switcher system (see Table 4.1).
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Making a Switch

Ross routing systems are destination driven: you must first select a destination and then select the required source to be routed.

A switch can be made with or without a TAKE button assigned to the menu. If there is no TAKE button assigned, a switch is made when the source/crosspoint/macro button is pressed. If a TAKE button is assigned to the menu, the switch is made when the TAKE button is pressed.

If the RCP-QE is connected to an NK series routing system, an NK-VRC may be configured to provide resource (tie-line) management. Refer to the NK-VRC User Guide for details.
Switching with a Breakaway, Destination, and Source

To make a switch

1. Press the button(s) for the level(s) or breakaway that you want to use.

   ![Example of an Unselected SRC Button](SDI)

   If you do not select a custom breakaway or level button, the default breakaway is used.
   To de-select a level, press the button again.

2. Press the destination button that you want to use.

3. Press the source button that you want to use.

   ![Example of a Selected SRC Button](VTR2)
   ![Example of a Selected SRC with a Breakaway Warning](VTR2)

   If a TAKE button is assigned to the menu, the text on the screen that identifies the source button alternates between **Take ?** and the selected source label. The source button flashes with the **TAKE** button.

4. If a TAKE button is assigned to the menu, press **TAKE**.

5. If you want to protect the destination, press the protect button (PROT) if it has been assigned (see “Protecting a Destination” on page 67).

   If you have selected the Breakaway Reset check box, the breakaway returns to the default breakaway after the switch is made.

6. If resource management is used, and if the requested switch includes a resource, the button displays a resource indicator.

7. After pressing the source button to initiate a switch:
   - if no rule can be found to connect two classes, it displays a **NO RULE** message
   - if no resource exists for the selected rule, it displays a **NO RSRCE** message
   - if resource exists but panel priority does not have access rights, it displays a **NO ACCES** message
Switching with a Crosspoint

When you make a crosspoint switch, the corresponding breakaway, destination, and source keys illuminate.

**To make a switch using a predefined crosspoint button**

1. Press the crosspoint button.

2. If a **TAKE** button is assigned to the menu, press **TAKE**.
   - If you want to protect the switch, press **PROT Off** if it has been assigned (see “Protecting a Destination” on page 67).
   - If you have selected the **Breakaway Reset** check box in the **Configuration** tab for the RCP-QE, the breakaway returns to the default breakaway after the switch is made.

Toggling Between Two Sources

If a chop button has been assigned to the RCP-QE, you can use this button to toggle between two sources.

**To toggle between two sources**

1. Press the button for the destination on which you want to receive the sources.
2. Press the button for the first source that you want to receive.
3. Press the **TAKE** button, if assigned.
4. Press the button for the second source that you want to receive.
5. Press the **TAKE** button, if assigned.
6. Do one of the following:
   - Press **CHOP** once to toggle slowly between the two sources (toggle cadence is 1700 ms). The status of the button changes to **CHOP Slow** and the two source buttons illuminate alternately.
   - Press **CHOP** twice to toggle rapidly between the two sources (toggle cadence is 400 ms). The status of the button changes to **CHOP Fast** and the two source buttons illuminate alternately.
7. Do one of the following:
   - If you are in slow chop, press **CHOP** twice to stop toggling between the two sources.
   - If you are in fast chop, press **CHOP** once to stop toggling between the two sources.

   The status of the button returns to **CHOP**.

Source and Destination Access

Some source and destinations are not needed for some panel locations. Or, security restrictions may dictate certain sources and destinations only be available from panels operated by users of a certain security level. By default, an RCP-QE has access to all the defined source and destination labels. Access to labels may be restricted in one of two ways:

1. Do not assign the restricted label to a button. Users will not see the label and therefore cannot access that resource.
2. Disable access via the Dest Label Access and Source Label Access configuration tables. Users will see the label if it is assigned to a button, but will see a “No access” upon selection. Source and Destination access tables are a convenient way to limit access without changing button layout.
To restrict access to sources and destinations on a RCP-QE

1. Open the RCP-QE Panel Config interface as outlined in the section “To open the RCP-QE Panel Config interface” on page 28.

2. Perform one of the following:
   • Select the Dest Label Access tab to restrict access to the destinations.
   • Select the Source Label Access tab to restrict access to the sources.

3. To prevent access to a certain label, clear the check box next to the required label.

4. Send the current configuration file to the device as outlined in the section “Sending a Configuration File to a Device” on page 74.
Breakaways and Levels

Routing systems often comprise many different signal types, and these may be in separate physical units. To control these units collectively or independently we assign a level so the control system may differentiate between them.

- A level is a single level (or layer) often comprising of a single signal type.
- A breakaway (or level mask) is a group of individual levels tied together to respond to a switch command.

What is a Breakaway?

A breakaway selects a group of levels to be switched. The default breakaway for the RCP-QE is the first eight router levels switching together (they are tied). If your routing switcher system does not use all of the predefined router levels (see Table 4.1), you should disable those levels that are not used in order to prevent a breakaway warning. If you only want to switch certain router levels, set up a custom breakaway for these levels and then assign this to a button on the RCP-QE (see “Configuring the Function Buttons on the RCP-QE” on page 49). If you select a breakaway that includes a level for which there is no routing switcher assigned, a breakaway warning is indicated in the bottom right corner of the button on the panel.

If the RCP-QE is connected to an Ultrix router or Ultricore Central Controller, the level numbers for setting breakaway pattern correspond to the ID column within the Ultrix/Ultricore Levels tab.

Before You Begin

Keep the following in mind when setting up your breakaways:

- The breakaway defined in the first row of the Breakaway table is the default breakaway.
- You can combine more than one router level in the same breakaway. Give the breakaway a meaningful name that covers the router levels that you want to use. Limit the name to 8 characters.
- You can assign multiple breakaway buttons to an RCP-QE, but you can select only one breakaway for a switch.
- A breakaway warning is caused when there is no response from the routing switcher system on one or more router levels, or a difference in status of any level in the currently selected breakaway when compared with the first level in the breakaway.
- If you change the level pattern in DashBoard, a breakaway button must be pressed on the panel for the new level assignment to take effect.
- If you click and drag across the level mask, you can rapidly select or de-select router levels.

For More Information on...

- breakaway warning icons on the physical button displays, refer to the section “LCD Buttons Overview” on page 14.

Setting up the Breakaways

Breakaways are groups of levels. Traditionally the default breakaway is the all levels (or TIED). The default RCP-QE TIED breakaway is the first eight levels (this may be edited). The first eight router levels are switched together when requested from the RCP-QE. If your routing switcher system does not use all of the router levels, you should remove the unused levels from the default breakaway.

Once you set up a breakaway and send the new configuration to the RCP-QE, each breakaway can be assigned to a button on the RCP-QE.

For More Information on...

- assigning breakaways to buttons, see “Assigning a Breakaway Button” on page 37.
To set up the breakaways

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. Locate the Breakaways area in the Configuration tab.
   * The Tied breakaway is the default. It is breakaway # 1 in the table (the first row in the table).

4. In the Tied row of the Breakaways area, de-select the router levels that are not used in your routing switcher system by clicking on the numbered squares. A selected router level is indicated by a blue square.
   
   For example, if router levels 2 and 3 are the only levels used, you should de-select levels 1, 4, 5, 6, 7, and 8 in the Level Mask column corresponding to Tied.

5. Double-click inside the Name column in the breakaway (# 2) below Tied.
6. Enter a name for the router level that corresponds to the first custom breakaway that you want to define.
   
   For example, enter SDI.
7. Select the corresponding router level(s) in the Level Mask column (see Table 4.1) and de-select any router levels that are not used.
8. Define the next custom breakaway in the Name column below the breakaways that you have defined previously. Repeat steps 4 to 8 until you have defined all the custom breakaways that you want to use.
9. Clear the remaining level masks from unused breakaways in the Breakaways table.
10. In the Configuration section, use the Breakaway Warning Mode list to select the breakaway with which you want to compare the status of the router levels in the current breakaway.
11. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Automatically Resetting a Custom Breakaway to the Default After a Switch

The default breakaway is defined in the first row of the Breakaways table in the Breakaways section. Typically, this breakaway is tied and it switches all router levels together. If you want only certain router levels to switch as defined in a custom breakaway, select that breakaway on the RCP-QE and then make the switch. The RCP-QE continues to use that breakaway (as indicated by the button being illuminated) for all further switches until another custom breakaway or the default breakaway is selected. If you want the RCP-QE to reset to the default breakaway immediately after a custom breakaway is used during a switch, then you should set the RCP-QE to reset the breakaway.
To automatically enable the resetting of the breakaway to the default breakaway after a switch
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration area, select the Breakaway Reset check box.
   ✱ You may need to scroll down the tab to locate the Breakaway Rest check box.
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a Breakaway Button

A predefined group of router levels assigned to a button. You select a breakaway as part of making a switch.

For More Information on...
• on configuring a breakaway, “Setting up the Breakaways” on page 35.

Keep the following in mind when assigning a breakaway to a button:
• If a level button is assigned for one or all of the router levels in a breakaway, then the level buttons corresponding to the router levels in the breakaway are illuminated when the breakaway button is selected. The level buttons do not illuminate when the default breakaway is selected.
• The breakaway button displays a breakaway warning when a switch that causes a breakaway error is made, except for the default breakaway (Breakaway 1).
• If you change the level pattern in DashBoard, a breakaway button must be pressed on the panel for the new level assignment to take effect.
• If you want to view the levels used in the current breakaway, hold the breakaway button (see “Viewing the Breakaways Assigned to an RCP-QE” on page 51). For help reading the levels from the hexadecimal expression, see Table 10.1.
• When you make a switch, you need to select the level(s) that you are switching using a breakaway. The breakaways should be set up before they are assigned to a button (see “Setting up the Breakaways” on page 35).

To assign a breakaway to a button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the breakaway.
   The Key dialog opens.
3. In the Button list, select Breakaway.
4. In the Value list, select the breakaway that you want to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard shows the name of the breakaway on the selected button. For example, Tied.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
   ✱ If you change the level pattern in DashBoard, a breakaway button must be pressed on the panel for the new level assignment to take effect.

Assigning a Breakaway Step Button

An RCP-QE may have several breakaways defined. If you want to cycle through the breakaways that have a non-zero level mask, a breakaway step button needs to be assigned to the RCP-QE. The button for the breakaway illuminates as it is selected. If you hold the breakaway step button for each breakaway, the levels defined in that
breakaway are represented by eight hexadecimal characters on the screen. For help with reading the levels from the hexadecimal characters refer to the chapter “Panel Hexadecimal to Router Level Conversion” on page 101.

![SDI]

**Figure 5.1 Example of a Breakaway Step Button**

**To assign a breakaway step button**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the breakaway step.
   The Key dialog opens.
3. In the Button list, select Function Key.
4. In the Value field, select Breakaway Step as the function to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard shows the name of the breakaway step (BRK STEP) on the selected button.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
   When the configuration is sent to an RCP-QE, the button shows the name of the currently selected breakaway with the breakaway step indicator.

**Assigning a Level Button**

A level button enables you to select one router level per button for a switch. While a breakaway is similar, breakaways can contain more than one router level. Pressing a level button selects that router level. Multiple levels can be selected. If a switch is made while a level button is pressed, the switch is made on that router level only.

- Multiple level buttons can be assigned on a panel.

**To assign a level to a button**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the level.
   The Key dialog opens.
3. In the Button list, select Level.
4. In the Value list, select the router level that you want to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard shows the selected level on the button. For example, Level 2.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

**Selecting Breakaways and Levels**

One level may be assigned to a button. You can assign multiple level buttons to an RCP-QE. You can select multiple level buttons prior to a switch. If you change the level pattern in DashBoard, a breakaway button must be pressed on the panel for the new level assignment to take effect.
Breakaway Warnings

A breakaway warning is caused by:

- No response from the routing switcher system on one or more router levels.
- A difference in status of any level in the currently selected breakaway when compared with the first level in the breakaway (or default breakaway if the Breakaway Warning Mode is set to default).
- If a breakaway warning is indicated on the button, it shows the routing switcher status in the current breakaway when compared to the router levels defined in the breakaway in the configuration.

To select a breakaway or level

1. Press the corresponding button.

   The button shows the color and inverse status for a selected breakaway or level.

   ![SDI Audio Left Audio Right Buttons](image)

   *Figure 5.2 Example of Level Buttons with Audio Left and Audio Right Selected*

   When a breakaway is selected, the status of the routing switcher shown on the button is the status of the lowest router level in the breakaway.

2. If you have selected a custom breakaway, and separate level buttons are assigned to the RCP-QE, the level keys corresponding to the levels in the breakaway also show the color and inverse status for a selected button.

   ✷ You cannot add a level to a custom breakaway by pressing a level button.

To de-select a breakaway

- Select another custom breakaway, the default breakaway, or a level button.

To de-select a level

- Press the level button again.

Using a Breakaway Step Button

A single button that selects the next breakaway in the Breakaway table on the Configuration tab (see “Setting up the Breakaways” on page 35). If you want to view the levels used in the current breakaway, hold the breakaway step button. The breakaway step button does not illuminate when the default breakaway is selected. For help reading the levels from the hexadecimal expression, refer to the chapter “Panel Hexadecimal to Router Level Conversion” on page 101.

Viewing the Breakaways Assigned to an RCP-QE

You can view the breakaways assigned to an RCP-QE if a breakaway step button is assigned to the RCP-QE. The breakaway step button cycles to the next breakaway in the list each time it is pressed and shows the name of the currently selected breakaway, with the breakaway step indicator in the bottom right of the button. As each breakaway is selected, the level(s) defined in that breakaway are illuminated if corresponding level buttons have been assigned to the RCP-QE.

To view the breakaways assigned to an RCP-QE

- Press the BRK STEP button repeatedly to cycle through the available breakaways.

   The BRK STEP button shows the selected status as you cycle through the breakaways. When the default breakaway is selected, the breakaway step button changes to the default status.

   ✷ If a breakaway warning exists, it is indicated at the bottom right of the breakaway button and the source button.
To view the levels of a breakaway

- Hold the breakaway button or the breakaway step button.

An 8-character expression appears on the button. Each character provides a hexadecimal representation of the use of four levels, from 32 to 29 on the left, through to 4 to 1 on the right. Refer to the chapter “Panel Hexadecimal to Router Level Conversion” on page 101 for a look-up table for reading the levels from the hexadecimal characters.

If level buttons have been assigned to the RCP-QE, these show the selected status. The level buttons show the default status when the default breakaway is selected.

Level Mask Mode

Level mask mode may be thought of as a breakaway (or group of levels) that can be edited by the user on the fly. For example, if there is no predefined breakaway assigned to the RCP-QE, or, there is no button assigned for a given breakaway, then a user may use level mask mode to create the required level pattern prior to a source selection.

Assigning the Level Mask Function to a Button

The Level Mask function can be assigned to an LCD button or to a function button.

For More Information on...
- the types of buttons on the panel, refer to the section “Front Panel Overview” on page 13.

To assign the level mask function to a button

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to assign to the level mask function.
   - The Key dialog opens.
3. Select Function Key from the Button list in the Key dialog.
4. Select Level Mask from the Value list.
   - The simulated RCP-QE in DashBoard displays “LEVEL MASK” on the selected button.
5. Use the Default Color and Select Color menus to assign a unique color scheme to the button display.
6. Close the Key dialog.
7. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Using a Level Mask Button

A Level Mask button enables you to quickly view what levels are selected, and edit which levels are included in the next crosspoint switch.

Table 5.1 summarizes the buttons displayed when the panel is in Level Mask mode.

![Figure 5.3 Example of the Level Mask Menu System](image-url)
To use level mask mode

1. Press and hold the LEVEL MASK button you assigned in the procedure “To assign the level mask function to a button”.

   - If the LEVEL MASK button is assigned to an LCD button, use the displayed MENU button to enter Level Mask mode (long press).
   - If the LEVEL MASK button is assigned to a fixed function button, use the MENU button to enter Level Mask mode (short press) and the LEVEL MASK button to exit Level Mask mode.

The Level Mask edit mode is indicated on the panel.

The currently selected levels are also indicated on the panel.

---

**Table 5.1 Level Mask Mode — List of Available Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| MENU   | If the Level Mask is assigned to an LCD button:  
|        | • Menu button is displayed as Menu / Exit  
|        | • Short press to exit Level Mask mode  
|        | • Long press to enter Level Mask menu  
|        | If the Level Mask is assigned to a fixed function button:  
|        | • Menu button is displayed as Menu  
|        | • Short press to enter Level Mask menu  
|        | • To exit Level Mask mode, press the Level Mask button |
| FOLLOW | Quickly selects all available levels |
| Levels | Toggle on/off that level to be included in the subsequent source selection |
| BACK < | Exits the current menu |
| SRC    | Displays when MENU is pressed and the panel is in Level Mask mode.  
|        | Press this button to enter Category Source Selection mode. Refer to the section “Using a Level Mask with Category Mode” on page 63 for details. |
| DEST   | Displays when MENU is pressed and the panel is in Level Mask mode.  
|        | Press this button to enter Category Destination selection mode. Refer to the section “Using a Level Mask with Category Mode” on page 63 for details. |
| Bway Select | Displays when MENU is pressed and the panel is in Level Mask mode.  
|        | Press this button to list the current defined breakaways for quick level group selection |
| Cancl&Exit | Displays when MENU is pressed and the panel is in Level Mask mode.  
|        | Press this button to cancel any changes and reverts back to the main page/menu. |
2. To select or unselect all levels, toggle the **FOLLOW** button.

3. To select or unselect a specific level, toggle the applicable Level button on the panel.

4. To exit level mask mode:
   - If the **LEVEL MASK** button is assigned to an LCD button, use the displayed **MENU** button to exit Level Mask mode (short press).
   - If the **LEVEL MASK** button is assigned to a fixed function button, use the **LEVEL MASK** button to exit Level Mask mode.
Menus

Menus can be used to group together certain functionality onto a single “menu page” within the RCP-QE system. Each menu page provides a new set of buttons that you can assign with new functions.

Setting Up Menus

You can store up to 250 menu pages in the RCP-QE. You can also define the fallback mode. This is what happens after an activity has been performed in a particular menu.

For example, if you set up a menu containing all the breakaways, another menu containing all the destinations, and another menu containing all the sources, you can set up the menus so that once you have selected a breakaway, the menu containing all the destinations is shown so that you can select a particular destination device. Following this, the menu containing all the sources is shown so that you can select a particular source device.

To set up a menu

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Menu Details tab.
3. To specify the number of menus required by your routing system:
   a. Use the Number of menus field to select the maximum number of menus.
   b. Click Update.
4. In the Menu Number 1 row:
   a. Click inside the Menu Name column and enter a name for the menu. The name can be up to 8 characters.
      This menu (Home) is by default the first menu.
   b. Press Enter.
   c. Click the Fallback Mode column.
   d. Choose one of the following from the list to select a fallback mode:
      • Fallback Off — After a button in the menu is pressed, the RCP-QE remains on the menu. If you select Fallback Off, the corresponding value in the Fallback Menu column is ignored. You must provide extra menu navigation buttons within the menu so that you can exit from the menu.
      • First Menu — After a button in the menu is pressed, the RCP-QE returns to the first menu (Menu 0 in the Menu Name column). If the button that is pressed is assigned as a menu link or a menu navigation button, then the RCP-QE goes to that menu.
• **Previous Menu** — After a button in the menu is pressed, the RCP-QE returns to the menu that it was on prior to the current menu. If the button that is pressed is assigned as a menu link or a menu navigation button, then the RCP-QE goes to that menu.

• **Specified Menu** — After a button in the menu is pressed, the RCP-QE returns to the menu specified in the Fallback Menu column. If the button that is pressed is assigned as a menu link or a menu navigation button, then the RCP-QE goes to that menu.

5. If you have selected **Specified Menu** as the fallback mode, enter the specific menu number in the **Fallback Menu** column.

6. Define the next menu in the **Menu Name** column below the menus that you have defined previously. Repeat steps 4 to 5 until you have defined all of the menus that you want to use.

7. Send the current configuration file to the device (see “**Sending a Configuration File to a Device**” on page 74).

**Navigating the Menus**

The RCP-QE provides two methods of moving through menus on the panel:

• **Menu Link** buttons — provide direct links to any menu.

• **Menu Navigate** buttons — enable you to navigate up or down through the menus as defined by the menu details settings. The Previous/Next function is similar to the Back/Forward buttons in a web-browser application.

**Assigning a Menu Link Button**

A Menu Link accesses a predefined menu via a single button. You can assign a predefined menu to a button on the RCP-QE.

**For More Information on...**

• how to set up a menu see “**Setting Up Menus**” on page 43.

**To assign a menu to a button**

1. Open the RCP-QE Panel Config interface (see “**To open the RCP-QE Panel Config interface**” on page 28).

2. On the simulated RCP-QE, select the button that you want to use for the menu link.

   The **Key** dialog opens.

3. In the **Button** list, select **Menu Link**.

4. In the **Value** field, use the list to select the menu you want to assign to the button.

5. Close the **Key** dialog.

   The simulated RCP-QE in DashBoard shows the menu on the selected button. For example, **Menu 3**.

6. Click the **Menu** list below the simulated RCP-QE and select the menu that you have just assigned.

7. Assign functions to the buttons in this menu (see “**Configuring the Function Buttons on the RCP-QE**” on page 49).

   For example, if this menu is for the purpose of selecting a destination, assign the buttons as destinations. You may choose to have this destination menu fall back to a source menu.

8. Send the current configuration file to the device (see “**Sending a Configuration File to a Device**” on page 74).

   ✴ A Menu Link button corresponding to the current menu will illuminate with the Selected Color settings.

**Assigning Menu Navigation to a Button**

A specific menu destination assigned to a button. You can set the button to return to **Menu Number 1 (Home)**, the next or previously visited menu, or go up or down a menu as defined on the **Menu Details** tab in the Panel Configuration editor.
If you have multiple menus assigned in the RCP-QE, you may want to include some navigation buttons to enhance movement through the menus.

**To assign menu navigation to a button**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to use for menu navigation.
   The *Key* dialog opens.
3. In the *Button* list, select *Menu Navigate*.
4. Use the *Value* list to select one of the following options:
   - *Home* — returns to the menu defined in *Menu Number 1* on the *Menu Details* tab.
   - *Next Menu* — goes to the next menu if one is held in the buffer.
   - *Previous Menu* — goes to the previously used menu if one is held in the buffer.
   - *Up Menu* — goes up a menu as defined on the *Menu Details* tab.
   - *Down Menu* — goes down a menu as defined on the *Menu Details*.
   - *XPoint Layer* — shows the breakaway, destination, or source for any visible crosspoint buttons. You can step through the layers of a crosspoint by pressing the crosspoint layer button. If XPoint Layer is selected, you can cycle through the current breakaway, destination, and source on any visible crosspoint buttons by repeatedly pressing the navigation button. The navigation button shows the current layer.
5. Close the *Key* dialog.
   The simulated RCP-QE in DashBoard shows the type of navigation on the selected button. For example, *UP MENU*.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

**Returning to the Home Menu**

You can use DashBoard to return to the Home menu if the RCP-QE is not responding to button presses. The Home Menu is defined as Menu Number 1 in the Menu Details tab.

To return to the Home menu

1. Open the RCP-QE Panel Config interface for the RCP-QE that is not responding (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the *Configuration* tab.
3. In the *Configuration* section, select the *Return to Home Menu* check box.
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
   The RCP-QE returns to the *Home* menu.
Functions

This chapter briefly summarizes how to assign a function to one of the buttons on the hard panel.

For More Information on...
• the physical buttons on the hard panel, refer to the section “Front Panel Overview” on page 13.

What is a Function?

The RCP-QE has some special function tasks that can be assigned to any button on the panel. The available functions are detailed below.

Take (TAKE)

A button assigned to the TAKE function acts as a trigger that ends a hold on a switch sequence. This enables you to press the required breakaway, destination, and then source button combination, or crosspoint button or macro button, but not activate the switch until TAKE is pressed. If you have a TAKE button assigned to an LCD button, it affects the behavior of that menu only. If you do not have a TAKE button assigned to the menu, then a switch is made as soon as the source/crosspoint/macro button is pressed.

By default, Button 4 of the non-LCD buttons is assigned to the TAKE function. The task buttons functions are global in that they affect every LCD menu. You must use it to activate any switch that is set up.

Protect (PROT)

A Protect function can be used to protect (or lock) a specific destination. This prevents other users from changing the status. Refer to the chapter “Protects and Locks” on page 65 for more information on this function.

Chop (CHOP)

A single button that starts a slow or fast toggle between the two most recently selected sources for a given destination.

Deassign (DE-ASN)

The Deassign function can be utilized with Machine Control routing and/or resource management routing as follows:

• Machine Control — The Deassign function 'un-routes' a machine control source/destination port, effectively disconnecting it from other machine control ports. Refer to the chapter “Machine Control” on page 69 for more information.

• Resource Management — The Deassign function parks the resource and/or destination. Resource and destination combinations require source to connect to when a resource is no longer in active use and ‘back in the pool’ of resources for other routes to make use of. Refer to the NK-VRC User Guide for details.

Refer to the section “Configuring a De-assign Button” on page 70 for more information on this function.

MC Key (MC KEY)

A MC Key button provides a convenient method for toggling reciprocal switching on and off when machine control is used. Refer to the chapter “Machine Control” on page 69 for more information on this routing mode.

Panel Lock (LOCK)

A Panel Lock is a function that prevents any key on the RCP-QE from functioning to prevent unintended button presses. Refer to the chapter “Protects and Locks” on page 65 for more information on this function.
Breakaway Step (BRK STEP)

A BRK STEP function allows a user to cycle through the list of defined breakaways. This enables you to conserve buttons instead of dedicating several buttons to Breakaway buttons. Refer to the section “Assigning a Breakaway Step Button” on page 37 for more information on this function.

Assigning a Function to an LCD Button

This section provides a generalized procedure for assigning a function to an LCD button. Refer to the sections and chapters for details on a specific function.

To assign a function to a panel button

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to use for the function.
   The Key dialog opens.
3. In the Button list, select Function Key.
4. Use the Value list to assign a specific function to the button.
5. Close the Key dialog.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a TAKE Button

If you want to pre-load a switch sequence but delay the switch, assign a TAKE button on the menu. If a TAKE button is assigned, then all switches on that menu are activated by pressing the TAKE button instead of the source/crosspoint/macro button. If the fixed function button does not have a TAKE assigned, you should assign a TAKE button on each menu that requires this switching mode.

Keep the following in mind when assigning a TAKE button:

• A TAKE function assigned to an LCD button only functions for the menu (page) where it is defined.
• A TAKE function assigned to a Function button (non-LCD) acts globally regardless of the current menu.

To assign a TAKE button

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to configure.
   The Key dialog opens.
3. In the Button list, select Function Key.
4. In the Value field, select Take as the function to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard displays “TAKE” on the selected button.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
   If a take button is assigned, the selected source/crosspoint/macro button and the TAKE button flash to indicate that the remote control panel is waiting for TAKE to be pressed.

Assigning a Chop Button

If you want to toggle two different sources to the same destination, assign a chop button to the RCP-QE. For example, the destination may be the monitor that you are viewing, and the sources may be feeds from two different
To assign a chop button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to configure.
   The Key dialog opens.
3. In the Button list, select Function Key.
4. In the Value field, select Chop as the function to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard displays “CHOP” on the selected button.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Clearing a Function from a Button
A label (UN-ASN) indicating that the button does not have any of the button functions assigned to it and therefore does nothing when pressed. Select it to clear a button of any function assignment. If a button is not used for any function it should be unassigned.

To clear a function from a button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button from which you want to clear a function.
   The Key dialog opens.
3. In the Button list, select Clear Key.
4. Close the Key dialog.
   The simulated RCP-QE in DashBoard blackens the selected button.
5. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Configuring the Function Buttons on the RCP-QE
The RCP-QE is programmed in the factory with eight default Function button assignments (see “Default Configurations” on page 25). If this default button assignment is not suitable for your routing switcher system, you can easily customize and save the configuration using DashBoard.

Assigning a function to a non-LCD button requires you to click the required button on the simulated panel to open the Function Key Configuration dialog. This dialog lists the available button functions. Selecting a function from the list displays the configurable aspects of that particular function to the right of the list. The procedure and options for configuring a Function button is similar to configuring the other buttons on the hard panel.

To configure a Function button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the Function button that you want to configure.
   The Function Key Configuration dialog opens.
3. In the **Button** list, select a function to assign to the button.

   The **Value** column updates depending on the function selected in the Button list.

4. Use the **Value** column to further define the Function button. Refer to the section “**Function Key Configuration Dialog**” on page 85 for a list of the options available in Function Key Configuration dialog.

5. Use the **Default Color** menu to specify the color of the physical button when it is not selected by the user.

6. Use the **Selected Color** menu to specify the color of the physical button when it is selected by the user.

7. Close the **Function Key Configuration** dialog.

   The simulated RCP-QE in DashBoard blackens the selected button.

8. Send the current configuration file to the device (see “**Sending a Configuration File to a Device**” on page 74).
Macros

This chapter provides instructions for creating and editing macros, assigning a macro to a button, and using macros via the hard panel.

What is a macro?

A macro is a sequence of events (e.g. switches) that are assigned to a button. If you want to perform several tasks with the press of a single button, assign a macro button to the RCP-QE and then record a macro using this button.

Assigning a Macro Button

You can assign up to 40 macros to an RCP-QE.

To assign a macro to a button

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the macro.
   The Key dialog opens.
3. In the Button list, select Macro.
4. In the Value list, select the macro number that you want to assign to this button.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard shows the name of the macro on the selected button. For example, Macro 1.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Recording a Macro Using the Panel

Macros can be recorded using the buttons on the RCP-QE. You may record up to 112 button presses in a macro. A macro button must be assigned on the RCP-QE before you can use it to record the macro. For more information on assigning a macro, see “Assigning a Macro Button” on page 51.

To record a macro using the panel

1. On the RCP-QE, hold the Macro #x button until the button shows Macro Rec.
2. Release the button.
   The button flashes slowly, indicating that the RCP-QE is now ready to record a macro.
3. Press the required buttons for the macro in the correct sequence until your task is completed.
   Each button acknowledges that it has been pressed by flashing briefly.
4. Press the Macro #x button again to end the recording process.
   The macro is recorded.

If you unassign the Macro #x button from the macro function, the recorded macro is held in memory. You can reassign the macro to a button using the same macro number under which the macro was recorded.

Editing a Macro Using the Panel

You can add extra button sequences to an existing macro or you can join two existing macros together.
To add to a macro using the panel

1. On the RCP-QE, hold the **Macro #x** button until the button begins to flash rapidly.
2. Release the button.
   The button flashes slowly, indicating that the RCP-QE is now ready to record a macro.
3. Hold the **Macro #x** button again.
   The selected macro is played back internally and is then ready to receive the additional button sequences.
4. Do one of the following:
   - To add an extra button sequence, press the required buttons to add to the macro in the correct sequence until your task is completed.
   - To add an existing macro, press the button for the macro you want to add.
   Each button acknowledges that it has been pressed by flashing briefly.
5. Press the **Macro #x** button again to end the recording process.
   The existing macro is overwritten with the new macro.

Configuring a Macro using DashBoard

Macros can be configured in DashBoard using the **Macro Events** tab.

To configure a macro using DashBoard

1. Assign a macro to a button (see “Assigning a Macro Button” on page 51).
2. In **DashBoard**, open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
3. Select the **Macro Events** tab.
4. In the **Num. Rows.** box of the macro you want to configure, enter or select the number of events to be assigned.
5. Click **Update** to add the events to the **Event** column of the macro.
6. In the **Function** column, use the list to select the function to perform for the event. Choose from the following:
   - **Switch** — performs a standard crosspoint switch.
   - **Macro** — performs a macro within the executed macro.
     The Output column is the macro number and the other columns have no effect.
   - **Protect** — creates a protect condition on the destination of the selected crosspoint (see “Assigning a Protect Button” on page 65).
     The Output column is the output number, the Input column is the protect status (0 = release the protect for the output, 1 = take protect for this output), and the Level column has no effect.
   - Protect within a macro operates differently than that of a RCP-NKQ controller. The RCP-QE will assert a protect regardless of the current protect status. The RCP-NKQ would toggle the current protect status.
7. In the **Output** column, perform the following:
   a. Click inside the **Output** table cell.
   b. Enter a destination output number for the event.
8. In the **Input** column, perform the following:
   a. Click inside the **Input** table cell.
   b. Enter a source input number for the event.
9. In the **Level Mask** column, select the level mask(s) for the device affected by the macro. A selected router level is indicated by a blue square.
Each function can occur on any available level, independent of any other function within the same macro event.

10. Repeat Steps 6 to 9 for any remaining events of the macro.

11. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a Name to a Macro using DashBoard

Macros can be assigned custom names in DashBoard using the Macro Names tab.

To assign a name to a macro using DashBoard
1. In DashBoard, select the Macro Names tab.
2. Click inside the Name table cell of the macro.
3. Enter a name.
4. Press Enter.
   The macro name is added to the button.

Using a Macro

Ensure you have recorded a macro and assigned it to a physical button on the hard panel.

To use a macro
1. Create a macro (see “Assigning a Macro Button” on page 32).
2. Press the macro button.
3. If a TAKE button is assigned to the menu, press TAKE.
Salvos

This chapter provides instructions to assigning a salvo to a button and how the RCP-QE uses salvos.

What is a salvo?

A salvo is a predefined list of switch events and is executed when a salvo button is pressed. Salvos are stored within a central controlling device such as an Ultrix router or Ultricore Central Controller and may be accessed by any Remote Control Panel within the system. Salvo names are handled by the central controlling device and update the RCP-QE salvo names list automatically.

Assigning a Salvo to a Button

This function is only available when connected to an Ultrix router or Ultricore Central Controller.

To assign a salvo to a button

1. Open the RCP-QE Panel Config interface as outlined in the section “To open the RCP-QE Panel Config interface” on page 28.
2. On the simulated RCP-QE, select the button that you want to use for the display. The Key dialog opens.
3. In the Button list, select Salvo.
4. Use the Value list to select one of the Salvo names.
5. Send the current configuration file to the device as outlined in the section “Sending a Configuration File to a Device” on page 74.

Using a Salvo

This function is only available when connected to an Ultrix router or Ultricore Central Controller.

A salvo is a predefined list of switch events. Salvos are stored within a central controlling device such as an Ultrix router or Ultricore and may be accessed by any Remote Control Panel within the system. Salvo names are handled by the central controlling device and update the RCP-QE salvo names list automatically.

To use a salvo

1. Create a salvo as outlined in the Ultrix or Ultricore documentation.
2. Press the assigned Salvo macro button. This is the button you configured using the procedure “To assign a salvo to a button” on page 36.
3. If a TAKE button is assigned to the menu, press TAKE.
Category Modes

The Ultricore control system allows the grouping of sources, destinations and levels into categories for quick navigation on large routing systems. The following category modes are available:

- **Group Category** — This mode allows a user to organize database resources (sources, destinations, and levels) into folders and sub-folders with arbitrary group names. Categories within categories are also possible.
- **Category/Index** — This mode allows a user to piece together or build up the final resource name from category names and index identifiers.
- **Legacy Category** — This mode is available to maintain backward compatibility with earlier RCP-QE models (17 button variants).

**Category Mode Setup on the RCP-QE**

- This function is only available when connected to an Ultrix series router or Ultricore Central Controller.

*For More Information on...*
- configuring the category modes, refer to the *Ultrix User Guide* or the *Ultricore User Guide*.

**Assigning a Category Button on the RCP-QE**

The default layout of the RCP-QE assigns a Category button to the lower left fixed function button.

**To assign a Category Mode button**

1. Open the RCP-QE Panel Config interface as outlined in the section “To open the RCP-QE Panel Config interface” on page 28.
2. On the simulated RCP-QE, select the button that you want to use for the display.
   - The **Key** dialog opens.
3. In the **Button** list, select **Category Mode**.
4. Send the current configuration file to the device as outlined in the section “Sending a Configuration File to a Device” on page 74.

**Specifying the Category Mode on the RCP-QE**

Some options unique to Category Mode are available to provide varying operating experiences. These options are located in the **Category Mode** area of the RCP-QE **Configuration** tab. (Figure 10.1)

**To specify the category mode**

1. Select the category mode the panel should operate in; Category/Index (Classic), Group, or, Legacy
2. Use the **Show Uncategorized Items in Group Mode** to specify the mode.
   - Selected — a check mark in this box will enable all uncategorized sources and destinations to show in the top level of the group category selection.
   - Cleared — clearing this box this will force the RCP-QE to display only the sources/destinations as defined by the Ultricore Group Categories tab.
Using Group Category Mode

★ This function is only available when connected to an UltraT router or UltraCore Central Controller.

Group Category allows user to organize database resources into folders and sub-folders with arbitrary group names. The group name is not required to match the resource names (it is similar to setting up file folders on your PC). This group categorization is useful where user has a need to group resources based on their operational regions, events, personnel credentials etc.

For More Information on...
- configuring Group Category mode, refer to the UltraT User Guide or the UltraCore User Guide.

Example Groups

Figure 10.2 provides an example of group categories in an UltraT database where:

- Group 1 includes resources Dest 1, Dest 2, Dest 3, Src 1, and Src 2. Notice that Group 1 also contains a sub-group which includes Dest 10, Dest 11, Dest 12, Src 10, Src 11, and Src 12.
- Group 2 includes resources Dest 6, Dest 7, Src 3, Src 4, and Src 5.
- Src 3 is included in two groups; Group 2 and Group 1. This is a valid configuration.

![Example of Group Categories in an UltraT Database](image)

Figure 10.2  Example of Group Categories in an UltraT Database

Figure 10.3 illustrates an RCP-QE18 with a top page displayed showing configured groups.

![RCP-QE18 — Example of Group Categories](image)

Figure 10.3  RCP-QE18 — Example of Group Categories
To switch Src5 to Dest 12

1. Press **Dest 12** on the RCP-QE18 panel.

2. The panel updates to indicate the current destination selection is **Dest 12**.

3. Press **Src 5** on the RCP-QE18 panel.

Selecting Uncategorized Resources

Resources that are not assigned to group categories may be accessed if configured to do so. The 'Show uncategorized Items in Group Mode' setting enables or disables this functionality.
To select uncategorized resources

1. Press the uncategorized destination button. In this example, **DEST 13** is pressed.

2. The panel updates to indicate the current destination selection is **Dest 13**.

3. Press the uncategorized source button. In this example, **SRC 13** is pressed.

---

Using Category/Index Mode

Category/Index mode (also referred to as classic category mode), allows alpha-numeric extensions to labels to 'build up' the final label selection. For example, VTR 1 - 6 may be expressed as a VTR label with numerical extensions 1 through 6. Similarly, alpha extensions may be used, for example, VTR A - E for VTRs A through E.

Destination and source names are split into substrings - the first substring traditionally referred to as the 'category', and subsequent substrings the 'indices' ie Category VTR index 1 through 6. As source/destination names become more complex, an index may not be the final part of the selection name. For example, consider the source names CG TX 1 and CG TX 2; Category Index mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be extrapolated to cover a large range of sources and destinations.
Example of a Category/Index Setup in an Ultrix/Ultricore Database

The resources available are:

<table>
<thead>
<tr>
<th>Sources / Destination Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAM 1</td>
</tr>
<tr>
<td>CAM 2</td>
</tr>
<tr>
<td>CAM 3</td>
</tr>
<tr>
<td>CAM 4</td>
</tr>
<tr>
<td>CAM 5</td>
</tr>
</tbody>
</table>

The possible categories and indexes would be:

<table>
<thead>
<tr>
<th>Categories</th>
<th>Indexes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAM_a</td>
<td>1</td>
</tr>
<tr>
<td>SAT_</td>
<td>2</td>
</tr>
<tr>
<td>CG_</td>
<td>3</td>
</tr>
<tr>
<td>EDIT_</td>
<td>4</td>
</tr>
<tr>
<td>VTR</td>
<td></td>
</tr>
</tbody>
</table>

a. The “_” characters represents a blank space. This indicates the category will filter resources with a space in the name (e.g. the CAM_ category will allow resources named CAM 1, CAM 2 but not CAM3).

For More Information on...

• CAT/Index mode for the Ultricore, refer to the *Ultricore User Guide*.
• CAT/Index mode for the Ultrix, refer to the *Ultrix User Guide*.

Examples of Using Category/Index Mode on the RCP-QE

To select the destination EDIT C

1. Press the DEST button.

2. The panel updates to display only the categories with destinations.

3. Press EDIT.
4. The panel updates to display only the destinations assigned to `EDIT_<index>` destination.

5. Press C.

6. Press SELECT to confirm your choices.

**To select the source CG TX 2**

1. Press the SRC button.

2. The panel updates to display only the categories with sources.

3. Press CG > TX.

4. Press 2.

**Using Legacy Category Mode**

* This function is only available when connected to an Ultrix router or Ultricore Central Controller.

Legacy mode allows the grouping of sources and destinations in a hierarchical tree structure similar to the 'breadcrumb' user interface pattern found on many websites. The traditional menu structured navigation pattern is
available once the Category Index mode is exited or the user has made a selection. The assignment of sources and destinations is defined within a central controlling device such as the Ultrix router or Ultricore.

**To enter Category Index mode**

1. Press the **CAT MODE** button to enter Category Index mode. This is the button you configured using the procedure “To assign a Category Index mode button” on page 37.

   ![CAT MODE button]

   A Category menu opens.

   ![Category menu with buttons: EXIT CTGRY, SRC, DEST, LEVEL]

2. Press Sources, Destinations, or Levels as required.

   Sub-categories and selection keys (source/destination/level selection) are now available. An example is below.

   ![Example menu: SRC< SAT, CBS, CNN]

3. If assigned within the category structure, numerical extension for like label prefixes presents a numerical keypad for selection.

   ![Example menu: SRC< SAT, CBS, AUDIO, LEVEL 1, 2]

4. Pressing the left-most button with the back arrow, or the category name before the current category traverses back up the tree one step.

**Using a Level Mask with Category Mode**

Level Mask mode may be thought of as a breakaway that can be edited by the user on the fly.

**To use a level mask**

1. Assign the level mask function to a button. Refer to the section “To assign a function to a panel button” on page 48 for details.

2. Press and hold the button configured in step 1 to enter Level Mask Edit mode.

   ![Level Mask button: inactive]

   ![Level Mask button: active]

3. Toggle the required levels on/off as required. (Press a Level to turn on, press again to turn the Level off).

4. Press **Menu/Exit** to return to the previous page.

5. Press and hold **Menu/Exit** to enable Category Mode.
# Protects and Locks

This chapter defines when to use a protect and lock, configuring a Protect or Lock button, how to protect a destination, and how to clear protects held by a RCP-QE.

## What is a Protect?

A single button that places a block on the current destination, preventing it from being controlled (selecting other sources) by other remote control panels. The **Protect** button may also be held down to panel lock the RCP-QE.

## What is a Panel Lock?

A single button that provides a convenient method for locking the RCP-QE against accidental or unwanted changes. The panel lock function can also be set by selecting the Panel Locked check box on the Configuration tab of the Panel Config interface or holding down a **Protect** button.

## Assigning a Protect Button

To prevent switching of critical crosspoints by others, assign a protect button for use on the RCP-QE. The protect function ensures that the selected destination can only receive the selected source across the selected levels. Once protected, the selected levels on a destination cannot be switched by other remote control panels (or by the same remote control panel if **Block All Panels** is selected). The source is not protected and can be freely routed to other destinations if required. You can protect any number of destinations.

**For More Information on...**

- protecting a destination, refer to the section “Protecting a Destination” on page 54.
- using the protect button to lock the RCP-QE against all button presses, refer to the section “Locking the RCP-QE” on page 54.

**To assign a protect button using DashBoard**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, click the button that you want to use for the level.
   
   The **Key** dialog opens.
3. In the **Button** list, select **Function Key**.
4. In the **Value** list, select **Protect** as the function to assign to this button.
5. Close the **Key** dialog.
   
   The simulated RCP-QE in DashBoard shows the protect (**PROT**) on the button.
6. Select the **Configuration** tab.
7. In the **Configuration** section, select the mode of protection that you want to use for the protect button. Use the information in Table 11.1 as a guide.
8. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a Panel Lock Button

It may be necessary at times to lock the RCP-QE from access to the front panel. If this function is required, assign a panel lock button. You can also lock the RCP-QE using the Panel Locked check box on the Configuration tab (see “Locking a Panel from DashBoard” on page 66). When a panel lock is applied, changes to the RCP-QE can still be made through the Panel Config interface in DashBoard.

To assign a panel lock button

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to use for the panel lock.
   
   The Key dialog opens.
3. In the Button list, select Function Key.
4. In the Value field, select Panel Lock as the function to assign to this button.
5. Close the Key dialog.

   The simulated RCP-QE in DashBoard shows the lock on the selected button.

Locking a Panel from DashBoard

You can use DashBoard to lock access to the front of a remote control panel. The remote control panel can only be unlocked locally if you have assigned a panel lock or protect button. If these buttons have not been assigned, then the remote control panel may only be unlocked via DashBoard.

To lock the RCP-QE

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration section, select the Panel Locked check box.
   
   ✷ You may need to scroll to the bottom of the Configuration tab to access the Panel Locked check box.
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

   The RCP-QE is locked.
   
   ✷ If a panel lock button is assigned, it can be pressed to unlock the RCP-QE.
   
   If a protect button is assigned, it can be held to unlock the RCP-QE.
   
   If neither of these buttons are assigned, the RCP-QE can only be unlocked by clearing the Panel Locked check box in DashBoard and then sending the configuration file to the device.

<table>
<thead>
<tr>
<th>Protect Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Other Panels</td>
<td>The protected destination and level(s) <em>cannot</em> be switched to another source by other remote control panels. The protected destination and level(s) <em>can</em> be switched to another source on the current remote control panel.</td>
</tr>
<tr>
<td>Block All Panels</td>
<td>The protected destination and level(s) <em>cannot</em> be switched to another source by the current remote control panel or other remote control panels. This is also known as a Destination lock.</td>
</tr>
</tbody>
</table>
Locking the RCP-QE

You can lock the RCP-QE if a panel lock or protect button has been assigned to the RCP-QE.
The protect button must be held to lock the RCP-QE.

To lock the RCP-QE using a panel lock button

1. Press **LOCK Off**.
   *The panel lock key flashes red three times before returning to the default status. The label changes to **LOCK On**.
   *Every key on the RCP-QE becomes inactive, except for the **LOCK On** button.
2. If you want to unlock the RCP-QE, press **LOCK On**.
   *The text on the panel lock key changes to **LOCK Off**.

To lock the RCP-QE using a Protect button

1. Hold **PROT Off** for 3 seconds.
   *Every key on the RCP-QE becomes inactive except for the **PROT Off** key and **LOCK On** key, if assigned.
2. If you want to unlock the RCP-QE, hold **PROT Off** or press the panel lock key, if assigned.
   ✻ If a panel lock key is assigned to the RCP-QE, this key changes to **LOCK On** and the **PROT Off** key remains the same.

Protecting a Destination

You can use a protect button to prevent switching of critical crosspoints by others. The protect function ensures that the selected destination can only receive the selected source across the selected levels. Once protected, the selected levels on a destination cannot be switched by other remote control panels (or by the same remote control panel if **Block All Panels** is selected). The source is not protected and can be freely routed to other destinations if required.

You can protect any number of destinations.

You can set the extent of protection that is used via DashBoard, such as protected against other remote control panels or protected against all remote control panels (see “Assigning a Protect Button” on page 65).

To protect a destination

1. Make the switch.
2. Perform one of the following:
   • Press **PROT Off** if the protect is assigned to an LCD button; or
   • Press **PROTECT** if the protect function is assigned to a non-LCD button.
3. If you pressed a **PROT Off** button, verify that the status of the pressed button changes to **PROT Loc**, and the protection indicator is shown at the bottom right of both the protect button and the destination button.
   ✻ If you are protecting a destination on a level for which a routing switcher does not respond, a protect breakaway error (**BwayErr**) occurs.

To remove the protection from a destination

1. Press the button for the protected destination.
2. Perform one of the following:
   • Press **PROT Loc** if the protect is assigned to an LCD button; or
   • Press **PROTECT** if the protect function is assigned to a non-LCD button.
3. If you pressed a **PROT Loc** button, verify that the protection indicator is removed from the destination button.
Clearing Protects Held by an RCP-QE

A protect that is held by an RCP-QE prevents the crosspoint being changed by another user. A protect can be sent to the routing switcher from any connected remote control panel. Protects can be applied at any time and are indicated by the protection indicator at the bottom right of the destination key.

To clear one protect from an RCP-QE

1. Press the destination button that has the protection applied.
   The protection indicator is shown at the top right of the destination button.

2. Press PROT Loc.

To clear all of the protects from an RCP-QE

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration section, select the Clear Protect(s) check box.
4. Send the current configuration to the device (see “Sending a Configuration File to a Device” on page 43).

* Protects may be held by other remote control panels. Each remote control panel attached to a routing switcher has to have its protects cleared separately.
Machine Control

When configuring the RCP-QE, you have the option to enable Machine Control, and to add a Machine Control button to the panel.

What is Machine Control?

Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there is both a transmit (input to output) and reciprocal receive connection that is made for each port. For example, a switch from port 1 to port 2 involves a forward path (from port 1 input to port 2 output) and the reciprocal connection from (port 2 input to port 1 output).

In some cases however, there is a need to connect on the port’s input to several ports’ output (e.g. one device commanding many target devices) without making the reciprocal connection. This allows the commanding device to just broadcast commands and not receive from the many devices it communicates with.

Setting Up Machine Control

If your routing switcher system uses a machine control routing switcher to provide reciprocal switching of RS-422 signals, your RCP-QE must be set up to handle these switches. Machine control must be enabled in the RCP-QE and the router level used for machine control must match that set in the machine control routing switcher.

To set up machine control
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Configuration tab.
3. In the Configuration section, select the Machine Control Enabled check box. You may need to scroll to the bottom of the Configuration tab to access the Machine Control Level check box.
4. Use the Machine Control Level area to enter or select the machine control level to match the level that the machine control routing switcher has been assigned.
   ✡ If machine control is used as part of Ultricore system, this level number is the Row ID number from the Ultricore Database > Levels interface.
5. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Assigning a Machine Control Button

If your master device controls multiple slave devices, you need a machine control button to temporarily disable reciprocal switching until the last slave device is routed.

To assign a machine control button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button that you want to use for machine control.
   The Key dialog opens.
3. In the Button list, select Function Key.
4. Use the Value list to select MC Key.
5. Close the Key dialog.
   The simulated RCP-QE in DashBoard shows MC KEY on the selected button.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).
Configuring a De-assign Button

De-assign will disconnect a reciprocal machine control path through a machine control router, parking sources to their respective destinations. Similarly, if using resource management, de-assigning will park the resource inputs and outputs and de-allocate the resource to be used in other routes.

For More Information on...

To configure a de-assign button
1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. On the simulated RCP-QE, select the button from which to de-assign a machine control port.
   - The Key dialog opens.
3. In the Button list, select Function Key.
4. Use the Value list to select Deassign.
5. Close the Key dialog.
   - The simulated RCP-QE in DashBoard shows DE-ASIGN on the selected button.
6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Using a De-assign Button

The De-assign button has two-fold functionality: a single button that provides a convenient method for disconnecting machine control ports and, if using virtual routing, a single button that allows you to free up resources when they are no longer needed for a path.

De-Assigning a Machine Control Port

De-assign will disconnect a reciprocal machine control path through a machine control router, parking sources to their respective destinations. Similarly, if using resource management, de-assigning will park the resource inputs and outputs and de-allocate the resource to be used in other routes.

If you want to stop machine control on a particular port temporarily, you can park the port by de-assigning it.

To de-assign a machine control port
1. Press the button for the machine control port that you want to park.
2. Press DE-ASIGN.

To unpark the machine control port
- Make a machine control switch.

De-Assigning Resources

De-assigning resources can be done in two ways:
- Route a different source to that destination that does not require a resource. The assigned resource will automatically be de-assigned.
- Use the de-assign button.
To-deassign a resource

1. Select the destination to which the resource is attached.
2. Press DE-ASSIGN.

   If the selected destination does not include a resource, one of two things will occur:
   - If the panel is in MC mode, park the current destination (switch same source number to destination).
   - If the panel is not in MC mode, it displays the MC MODE? message.

🌟 The ability of a panel to de-assign a resource using the de-assign button will depend on the priority assigned to the panel and the resource in the NK-VRC virtual routing core.

Operating Linked Remote Control Panels

You can link multiple RCP-QEs together, or link them with one or more RCP-ME, RCP-NKMs, or RCP-NKQs, or combination thereof. The remote control panels must have panel link addresses set, as described in the section “Linking Remote Control Panels” on page 39. Once these addresses are set correctly, the remote control panels transfer status, request and response information between them. Effectively, the remote control panels combine to form one big remote control panel. Up to 10 remote control panels may be linked together.

🌟 Cross-domain panel linking (from RCP-QE to RCP-NK panels) is only available when using the NK-NET.

🌟 The input and output assign labels should be identical across all remote control panels.

Buttons Assigned to Functions

Once remote control panels are linked, they operate in a manner similar manner as to their the unlinked state operation. If a special function button (CHOP, DE-ASSIGN, or a PANEL LOCK, PROTECT, Breakaway, Breakaway Step or machine control) is assigned to one remote control panel, it is effective across all linked remote control panels, regardless of the location of other relevant buttons.

- A TAKE button does not operate across menus within the same remote control panel however, it does operate across linked remote control panels as long as it is on a current menu at the time that the source/crosspoint/macro key is pressed. For example, a TAKE function will only operate on a currently visible menu on any of the linked remote control panels. If a TAKE button is not visible, then the TAKE function will not operate.

- If a TAKE button is assigned, the selected source/crosspoint/macro button and the TAKE button flash to indicate that the remote control panel is waiting for TAKE to be pressed.

- Only a single CHOP button is supported.

- Only a single button is supported for any given MACRO.

- A PROTECT will operate across linked panels to each linked panels current protect mode. For example, if a PROTECT is issued from a linked panel with a Protect mode of “block_all”, but a linked panel has a Protect mode of “block_others” then the two linked panels will interpret the PROTECT function differently. This may have unintended consequences. It is recommended that all panels in the linked panel setup are configured with the same Protect mode. Refer to the section “Assigning a Protect Button” on page 65 for more information on the Protect mode options.

Destinations and Sources

Destinations and sources from different remote control panels may be selected. For example; a destination button is pressed on one linked panel, then a source selected on another linked panel will result in the router/s switching that source to that destination on the current breakaway.
Crosspoints

A crosspoint button is a source, destination, and breakaway all in one button offering single button press router switching. Crosspoints can only be programmed to a remote control panel via Dashboard. Crosspoint buttons operate normally in linked panel mode.

Switching

When a breakaway, destination and source are sent in a switch request from a remote control panel, each linked remote control panel receives the level mask (levels that make up the breakaway), destination and source information via a linked panel message, and either reflects the status, or behaves accordingly (for example, locking the remote control panel or entering macro record mode).

Breakaways

Breakaway numbers are not sent in the switch request, thus removing the need for identical breakaway definitions across linked remote control panels. As such, breakaway step is not available across linked remote control panels.

You can view the breakaways within the same remote control panel, in line with unlinked behavior.

Menus

Menus and menu navigation buttons are only effective on the remote control panel to which they are assigned.

Macros

Macros may be recorded or added across linked remote control panels.
Managing Panel Configurations

The parameters that you have set up on the Panel Config interface for an RCP-QE are stored to a configuration file on your DashBoard client PC. A configuration file can be recalled and applied to other remote control panels communicating with your DashBoard client PC.

Saving the Current Configuration for the RCP-QE

When you have finished making changes to the configuration of the RCP-QE, you should save the configuration file and then add the location of this file to the File Navigator pane so that you can open it later.

To save a new configuration file
1. Select the Panel Config interface containing the configuration that you want to save.
2. From the main toolbar in DashBoard, click Save As ( ) to save the current configuration.
3. Navigate to the folder in which you want to save the configuration file.
   ✭ The default location is Desktop\Documents.
4. Click Save.

To save an existing configuration
1. Select the Panel Config interface containing the configuration that you want to save.
2. In the File Navigator pane, select the configuration file to which you want to save the current configuration.
3. Click  to save the current configuration.

Adding a Directory to File Navigator Pane

You can create a directory (folder) in the tree view in the File Navigator pane in the DashBoard window to store your configuration files. This enables you to group configuration files into a single folder, allowing quick access to your files. This method is optional, you can still access your configuration files without creating a directory in the File Navigator pane.

For More Information on...
• the File Navigator pane in DashBoard, refer to the DashBoard User Manual.

To add the configuration file location to the File Navigator pane
1. Display the File Navigator pane in the DashBoard window as follows:
   a. Click Views in the DashBoard main toolbar.
   b. Click File Navigator.

   The File Navigator pane displays in the lower left corner of the DashBoard window.
2. In the toolbar of the File Navigator pane, click  .

   The Browse For Folder window opens.
3. Navigate to the folder where you saved the configuration file.
4. Select the folder.
5. Click OK.
Editing a Configuration File

Any saved configuration files can be accessed and opened via the File Navigator pane in the DashBoard window. You can also open a saved configuration file, make changes to it, save it, and then send it to a panel.

To edit a saved configuration file

1. In the File Navigator pane, navigate to the saved configuration file that you want to open.
2. Double-click the icon for the file.
   The saved Panel Config interface displays in the right pane of the DashBoard window with the name of the file displayed in the interface tab.
3. Update the settings in the Panel Config interface as required.
4. Follow the procedure “To save an existing configuration” on page 73.

Sending a Configuration File to a Device

When you have made changes to the configuration of a panel, the changes are not activated in that panel until those changes are sent to the hard panel. You can also choose to send the same configuration to multiple panels without using the File Navigator pane in DashBoard.

To send the current configuration to a panel

1. Configure your panel using the tabs and options in the Panel Config interface.
   ✷ If you want to send the default configuration to a panel, open the default configuration file from the File Navigator pane (see “To edit a saved configuration file” on page 74).
2. Click Send Configuration.
   The Send Configuration dialog opens.
3. From the list in the left column of the dialog, select the tab settings that you want to send to the device.
4. In the Select Devices list, select the panel to which you want to send the current configuration.
5. Click Send.
6. In the Basic Tree View in the DashBoard window:
   a. Right-click the panel node.
   b. Select Reload.
   The panel is reloaded with the new configuration.

Loading the Factory Defaults Using DashBoard

If you need to return the RCP-QE to a known configuration, you can use DashBoard to load the factory defaults.
This defaults the RCP-QE panel configuration (Panel Config interface settings) only, and not the connection configuration (Connection Editor).

**To load the factory defaults**

1. Open the RCP-QE Panel Config interface for the RCP-QE (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the **Configuration** tab.
3. In the **Configuration** section, select the **Load Factory Defaults** check box.
4. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

Ensure that only the **Home** page box is selected in the **Send Configuration** dialog. De-select all other pages or they will be sent to the device as well, thus changing the factory defaults.

The factory defaults are loaded.
Monitoring

This chapter provides information on the display options for the buttons, monitoring the panel in DashBoard, troubleshooting common problems, and the steps required to update the firmware on the hard panel.

Configuring the Button Display Options on the RCP-QE

You can set up the display options for each type of button on the RCP-QE so that you can distinguish between what types of functions have been assigned and whether or not the button is active.

• When a button is active, it shows the color and inverse settings for the selected state.
• When a button is not active, it shows the color and inverse settings for the default state.

You can select any of the available colors to represent default and selected states. You can also choose whether or not the default or selected state uses inverse. For example:

<table>
<thead>
<tr>
<th></th>
<th>Default state (the button is not selected), but the display is not inverted</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="DEFAULT" /></td>
<td>The button is selected, but the display is inverted.</td>
</tr>
<tr>
<td><img src="image2" alt="SELECTED" /></td>
<td>Default (the button is not selected), but the display is inverted.</td>
</tr>
<tr>
<td><img src="image3" alt="DEFAULT" /></td>
<td>The button is selected, but the display is not inverted.</td>
</tr>
</tbody>
</table>

To set the display options for a button type

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the Display Options tab.
As you make changes to the default and selected colors, the changes are shown immediately in the preview keys to the right of the Display Options section.

3. Use the **Mode** column to locate the function for which you want to configure the display options.

4. Click inside the **Default Color** table cell and use the list to select a default color for the button display of the function.

   If you want the text on the button to appear in inverse, select the Invert Default check box.

5. Click inside the **Selected Color** table cell and use the list to select a color for the button display of the function when it is selected.

   If you want the text on the button to appear in inverse, select the Invert Selected check box.

6. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

### Assigning a Display Status Function to a Button

Assign the display function to a button if you want to view the status of the currently selected input, output, or breakaway. This button will show the name of the currently selected input, output, or breakaway.

**To assign a display to a button**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).

2. On the simulated RCP-QE, select the button that you want to use for the display.

   The **Key** dialog opens.

3. In the **Button** list, select **Display**.

4. Use the **Value** list to select one of the following options:

   • **Current Output** — the button displays the currently selected output.
   
   • **Current Input** — the button displays the currently selected input.
   
   • **Current Breakaway** — the button displays the currently selected breakaway. If a level button is selected on the RCP-QE, the level mask is shown as eight hexadecimal characters on the face of the display layer button.

     For help reading the levels from the hexadecimal expression, refer to the chapter “Panel Hexadecimal to Router Level Conversion” on page 101.

   The simulated RCP-QE in DashBoard shows the type of display on the selected button, for example, **DISP INPUT**.

5. Send the current configuration file to the device (see “Sending a Configuration File to a Device” on page 74).

   When this configuration is sent to an RCP-QE, the button shows the label for the current source, destination, or breakaway (if the breakaway step button is used to cycle through the breakaways), for example **Server 1**, **Server 2**, or **SDI**.

### Viewing Status and Alarms in the DashBoard Tree View

An indication that alarms are present for a device is visible in the **Basic Tree View** pane. If a device has one or more alarms, a small circle appears in the icon for the device.
The status and alarms are also viewable in the Configuration tab of the Panel Config interface.

**To view the status and any alarms for an RCP-QE**

1. Open the RCP-QE Panel Config interface (see “To open the RCP-QE Panel Config interface” on page 28).
2. Select the **Configuration** tab.
3. View the status and alarms in the **Alarms** area of the tab. You may need to scroll down the tab to view this area.

The status of the RCP-QE is shown via a number of colored indicators as outlined in **Table 14.1**.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The device is connected and operational.</td>
</tr>
<tr>
<td>Yellow</td>
<td>An alarm is active. For example, a protect is active on the panel.</td>
</tr>
<tr>
<td>Orange</td>
<td>There is no active DashBoard connection. A forced connection is required.</td>
</tr>
<tr>
<td>Red</td>
<td>The device was rebooted. Refresh the Basic Tree View in DashBoard to clear this status.</td>
</tr>
</tbody>
</table>

### Troubleshooting

This section provides general information and tips for troubleshooting.

**Table 14.2 Troubleshooting**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>I am stuck on a menu with no way back.</td>
<td>A return loop was not set up when the menu was</td>
<td>Use DashBoard to return to the Home menu (see “Returning to the Home Menu” on page 42).</td>
</tr>
<tr>
<td></td>
<td>defined.</td>
<td></td>
</tr>
<tr>
<td>RCP-QE is not responding to DashBoard.</td>
<td>Information stored in the RCP-QE has been</td>
<td>Try the following until the RCP-QE responds:</td>
</tr>
<tr>
<td></td>
<td>corrupted.</td>
<td>• Reset the RCP-QE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Send the default configuration file to the RCP-QE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Load the factory defaults via DashBoard (see “Loading Factory Defaults Using DashBoard” on page 43).</td>
</tr>
<tr>
<td>The RCP-QE is not switching correctly.</td>
<td>The NK Series devices are not set up correctly</td>
<td>Use DashBoard to set up the devices with virtual routing enabled or</td>
</tr>
<tr>
<td></td>
<td>to operate with or without virtual routing.</td>
<td>disabled as required (see “Setting Up Virtual Routing and Resource Management” on page 40).</td>
</tr>
</tbody>
</table>
Upgrading the Software

The RCP-QE can be upgraded in the field via DashBoard. Note that DashBoard version 8.2.0 or higher is required for this procedure.

Contact Ross Technical Support for the latest software file for the RCP-QE.

Checking the Firmware Version

Firmware may be updated using DashBoard. Contact Ross Video Technical Support for the latest firmware.

To check the firmware version of a RCP-QE using DashBoard

1. Launch DashBoard.
2. In the Basic Tree View, expand the node for the required RCP-QE.
3. Double-click the Panel Config node.
   The Panel Config interface opens.
   The firmware version is shown in the Version field located at the top of the interface.

Upgrading the Firmware Version

Firmware upgrade files can be obtained by contacting Ross Video Technical Support.

To upgrade the RCP-QE firmware

1. Launch DashBoard.
2. In the Basic Tree View, expand the node for the required RCP-QE.
3. Double-click the Panel Config node.
   The Panel Config interface opens.
4. Click Send Firmware.
   The Open file dialog opens.
5. Navigate to where you have stored the firmware file and select it.
6. Click Open.
   The Confirm Upload dialog opens.
7. Click Continue.
   A progress bar displays. When the upload has completed, a confirmation dialog opens.
8. Click OK.
9. Click Reboot to restart the device and activate the new firmware.

Troubleshooting the Upgrade

If you encounter problems when upgrading your RCP-QE, verify the following:

• Your network settings on the RCP-QE are valid.
• The ethernet cable is properly connected.
• The file you are attempting to load is the correct file for the panel you are upgrading.
Dashboard Interface Overview

This section outlines the interfaces, menus, and parameters available in DashBoard for the RCP-QE.

RCP-QE Connection Editor Fields

The RCP-QE Connector Editor enables users to establish the RCP-QE network settings, such as the IP Address and TCP Port, assign the panel to a router group, and specify a unique identifier for the panel to be used in the DashBoard interfaces.

The RCP-QE can have up to three more NK-NETs configured as backups in the event that connection is lost to the primary NK-NET.

![Example of the RCP-QE Connection Editor](image)

Device Details Area

The Device Details area is located in the top portion of the RCP-QE Connector Editor. This area displays information that identifies the RCP-QE within your routing system. Table 15.1 briefly summarizes the fields displayed in the Device Details area.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Num (read-only)</td>
<td>#</td>
<td>The serial number is set in the factory before shipping and is unique to each device.</td>
</tr>
<tr>
<td>Version (read-only)</td>
<td>#.#</td>
<td>Displays the software/firmware version</td>
</tr>
<tr>
<td>Hardware Rev (read-only)</td>
<td>#</td>
<td>The hardware version of the RCP-QE</td>
</tr>
<tr>
<td>Details</td>
<td>&lt;text&gt;</td>
<td>Assigned by the user to give an RCP-QE specific details. For example, a physical location or a brief description of its use. This field has a maximum of 16 characters and is used for description and identification only.</td>
</tr>
</tbody>
</table>
Configuration Options

Newly assigned IP addresses and netmasks are checked for valid values before being applied to an RCP-QE. If the new values are invalid they will be discarded silently. Only a refresh of the RCP-QE Connection Editor will show that the values were not set.

The bottom half of the RCP-QE Connection Editor is organized into three areas: Network Settings, Servers to Connect to, and Connections. A toolbar at the bottom of the RCP-QE Connection Editor provides buttons for updating the panel.

Network Settings Area

Table 15.2  summarizes the options for specifying the network settings for the RCP-QE.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>#</td>
<td>Enter or edit the IP address of the device</td>
</tr>
<tr>
<td>Netmask</td>
<td>#</td>
<td>Enter or edit the IP netmask of the device</td>
</tr>
<tr>
<td>Gateway</td>
<td>#</td>
<td>Enter or edit the IP gateway of the device</td>
</tr>
<tr>
<td>TCP Port</td>
<td>#</td>
<td>Enter or select the Transmission Control Protocol port number used for network communication. By default, the TCP Port is 5000, and any client devices/apps should be setup with the same port number</td>
</tr>
</tbody>
</table>

Servers to Connect to Area

Table 15.3 summarizes the options for configuring communications between the RCP-QE and a server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>#</td>
<td>The order priority of the servers</td>
</tr>
<tr>
<td>IP Address</td>
<td>#.#.#.#</td>
<td>The IP address of the server</td>
</tr>
</tbody>
</table>
Connections Area
Displays the number of clients connected to the RCP-QE.

Bottom Toolbar
The bottom toolbar of the RCP-QE Connection Editor displays the following buttons:

- **Refresh** — Reverts to the configuration previously sent to the RCP-QE. The RCP-QE Connection Editor will display the last settings that were sent to the RCP-QE via the **Send Configuration** button.
- **Send Firmware** — Opens a file browser to select a software/firmware file to send to the RCP-QE.
- **Send Configuration** — Uploads the settings to the RCP-QE.

* All configuration items become active only after uploading by sending the configuration to the device.
- **Reboot** — Reboots the RCP-QE. This function does not clear the RCP-QE settings.
- **Close** — Closes the RCP-QE Connection Editor in DashBoard.

RCP-QE Panel Config Interface
The RCP-QE Panel Config interface enables users to setup device details, panel button assignments, menus, I/O assigns, and macros.

**Table 15.3 Servers to Connect to Area**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected (read-only)</td>
<td>Selected</td>
<td>There is a connection to the specified server</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>No valid connection to the specified server</td>
</tr>
</tbody>
</table>

Connections Area
Displays the number of clients connected to the RCP-QE.

Bottom Toolbar
The bottom toolbar of the RCP-QE Connection Editor displays the following buttons:

- **Refresh** — Reverts to the configuration previously sent to the RCP-QE. The RCP-QE Connection Editor will display the last settings that were sent to the RCP-QE via the **Send Configuration** button.
- **Send Firmware** — Opens a file browser to select a software/firmware file to send to the RCP-QE.
- **Send Configuration** — Uploads the settings to the RCP-QE.

* All configuration items become active only after uploading by sending the configuration to the device.
- **Reboot** — Reboots the RCP-QE. This function does not clear the RCP-QE settings.
- **Close** — Closes the RCP-QE Connection Editor in DashBoard.

RCP-QE Panel Config Interface
The RCP-QE Panel Config interface enables users to setup device details, panel button assignments, menus, I/O assigns, and macros.

**Table 15.4**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected (read-only)</td>
<td>Selected</td>
<td>There is a connection to the specified server</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>No valid connection to the specified server</td>
</tr>
</tbody>
</table>

Connections Area
Displays the number of clients connected to the RCP-QE.

Bottom Toolbar
The bottom toolbar of the RCP-QE Connection Editor displays the following buttons:

- **Refresh** — Reverts to the configuration previously sent to the RCP-QE. The RCP-QE Connection Editor will display the last settings that were sent to the RCP-QE via the **Send Configuration** button.
- **Send Firmware** — Opens a file browser to select a software/firmware file to send to the RCP-QE.
- **Send Configuration** — Uploads the settings to the RCP-QE.

* All configuration items become active only after uploading by sending the configuration to the device.
- **Reboot** — Reboots the RCP-QE. This function does not clear the RCP-QE settings.
- **Close** — Closes the RCP-QE Connection Editor in DashBoard.

RCP-QE Panel Config Interface
The RCP-QE Panel Config interface enables users to setup device details, panel button assignments, menus, I/O assigns, and macros.

**Table 15.4**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected (read-only)</td>
<td>Selected</td>
<td>There is a connection to the specified server</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>No valid connection to the specified server</td>
</tr>
</tbody>
</table>
Simulated RCP-QE Panel Area

The RCP-QE Panel Config interface displays a representation of the RCP-QE hard panel. (Figure 15.3)

1. **Function Buttons**
   This area represents the eight non-LCD buttons that come standard on each hard panel. You can assign the function and button colors for each button by selecting the button in DashBoard and using the Function keys dialog options.

2. **LCD Buttons**
   This area represents the function, source, and/or destination buttons configured for the RCP-QE. Click a button to open its **Button** menu and assign a function to the button.

3. **Hide Panel Button**
   Click this button to hide the simulated RCP-QE panel from the RCP-QE Panel Configuration Editor.

4. **Button <> Field**
   Click the arrow buttons to select a button from the panel or use the list to select a specific button.

---

**Table 15.4 Device Details Area**

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Details</td>
<td>Serial Num (read-only)</td>
<td>#</td>
<td>Displays the serial number set in the factory before shipping and is unique to each device</td>
</tr>
<tr>
<td></td>
<td>Version (read-only)</td>
<td>#.#</td>
<td>Displays the software/firmware version</td>
</tr>
<tr>
<td></td>
<td>Name (read-only)</td>
<td>&lt;text&gt;</td>
<td>Displays the unique identifier for the RCP-QE as specified in the RCP-QE Connection Editor.</td>
</tr>
<tr>
<td></td>
<td>Group (read-only)</td>
<td>#</td>
<td>Displays the group number assigned by the user to organize devices into groups. For example, users can assign separate group numbers for devices in different physical area.</td>
</tr>
<tr>
<td></td>
<td>Details (read-only)</td>
<td>&lt;text&gt;</td>
<td>Displays the additional information the user provided in the RCP-QE Connection Editor. For example, a physical location or a brief description of its use.</td>
</tr>
<tr>
<td></td>
<td>Address</td>
<td>#</td>
<td>This address is used within the overall control system to identify NK devices using resource management and protects. Each device must be given a unique T-BUS address to avoid communication conflicts. The valid value range for assigning an individual device T-BUS address is 1-255</td>
</tr>
</tbody>
</table>

a. Except when panel-linking is used.
5. Menu Field

Use this field to specify a button map configuration for the panel and edit its settings using the options in the Panel Config interface. The options listed in this field depend on the settings in the Menu Details tab.

* The edited settings are not applied to the hard panel until you click Send Configuration.

6. Copy From... Button

Click this button to open the Copy Menu From dialog box to select a button map configuration to copy to the one selected in the Menu field.

Function Key Configuration Dialog

When you select a Function button on the simulated RCP-QE hard panel, the Function Key Configuration dialog displays for that button.

For More Information on...

- the default settings for the panel buttons, refer to the section “Front Panel Overview” on page 13.

![Figure 15.4 Example of a Function Key Configuration Dialog](image)

The options in the Function Key Configuration dialog can change depending on the selection made in the first column of the dialog. In Table 15.4, Breakaway is selected in the first column and Tied is selected in the Value column.

For all functions, you have the option of configuring the Default Color and the Selected Color for that button.

- **Default Color** — specifies the color of the physical button when it is not selected by the user.
- **Selected Color** — specifies the color of the physical button when it is selected by the user.

The following sections briefly summarize the options to assign to a button.

**Destination and Source**

If you selected Destination or Source from the first column, the Value column updates to list the destination or sources available in the router database that the panel is communicating with.

**Crosspoint**

If you selected Crosspoint from the first column, the dialog updates to display a table with three columns: Output, Input, and Breakaway.
Function Key

If you selected **Function Key** from the first column, the **Value** column updates to display a list of options.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crosspoint</td>
<td>Output</td>
<td>Lists the destinations available in the router database</td>
</tr>
<tr>
<td></td>
<td>Input</td>
<td>Lists the sources available in the router database</td>
</tr>
<tr>
<td></td>
<td>Breakaway</td>
<td>Lists the breakaways configured in the router database</td>
</tr>
</tbody>
</table>

Table 15.6  **Function Key Dialog — Function Key Selected**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Key</td>
<td>Take</td>
<td>The button functions as a TAKE button. Pressing this button on the hard panel performs a Take transition.</td>
</tr>
<tr>
<td></td>
<td>Protect</td>
<td>Pressing this button on the hard panel places a block on the current destination, preventing its use by other sources.</td>
</tr>
<tr>
<td></td>
<td>Chop</td>
<td>Pressing this button on the hard panel starts a slow or fast toggle between the two most recently selected sources for a given destination.</td>
</tr>
<tr>
<td></td>
<td>Deassign</td>
<td>Pressing this button on the hard panel disconnects machine control ports or, when in virtual routing, allows you to free up resources when they are no longer needed for a path</td>
</tr>
<tr>
<td></td>
<td>MC Key</td>
<td>Pressing this button on the hard panel toggles reciprocal switching on and off when machine control is used</td>
</tr>
<tr>
<td></td>
<td>Panel Lock</td>
<td>Pressing this button on the hard panel locks the hard panel against accidental or unwanted changes.</td>
</tr>
<tr>
<td></td>
<td>Brk Step</td>
<td>Pressing this button on the hard panel selects the next breakaway in the Breakaway list on the Configuration tab.</td>
</tr>
<tr>
<td></td>
<td>Category</td>
<td>Pressing this button sets the hard panel into Category Mode. The category mode type is determined by the Configuration &gt; Category Mode menu.</td>
</tr>
<tr>
<td></td>
<td>Level Mask</td>
<td>Pressing this button sets the hard panel into Level Mask mode. The buttons update to indicate what level(s) are currently included in the next switch and allows you to edit those selections.</td>
</tr>
</tbody>
</table>
Level

If you selected **Level** from the first column, the **Value** column updates to display a list of levels available in the router database. Assigning a level to a button enables you to switch to a specific level in the database by pressing the physical button on the hard panel.

Breakaway

If you selected **Breakaway** from the first column, the **Value** column updates to list the breakaways configured on the Configuration tab. Assigning a breakaway to a button enables you to switch the (multiple) levels as specified by that breakaway. For example, Breakaway Two specifies that levels 1, 6, 8, and 10 are included. Assigning Breakaway Two to a Function button, and then selecting the corresponding physical button on the hard panel, will include levels 1, 6, 8, and 10 on the next switch.

Macro

If you selected **Macro** from the first column, the **Value** column updates to list the macros configured on the Macro Details tab. Assigning a macro to a button enables you to run that specific macro when the physical button on the hard panel is pressed.

Menu Link

If you selected **Menu Link** from the first column, the **Value** column updates to list the button configurations specified on the Menu Details tab. Assigning a menu to a button enables you to apply that button configuration when the physical button on the hard panel is pressed.

Menu Navigate

If you selected **Menu Navigate** from the first column, the **Value** column updates to list options for navigating through the menus for your hard panel.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Navigate</td>
<td>Home</td>
<td>Assigns the button the Home Menu. Pressing this button will apply the Home menu settings, as specified in the Menu Details tab, to the hard panel.</td>
</tr>
<tr>
<td></td>
<td>Next Menu</td>
<td>Pressing this button will advance the menu selection to the next menu in the list. For example, if Menu 3 is currently loaded, pressing Next Menu will load Menu 4.</td>
</tr>
<tr>
<td></td>
<td>Previous Menu</td>
<td>Pressing this button will return the menu selection to the last menu selected in the list. For example, if Menu 3 was loaded after Menu 10, pressing Previous Menu will load Menu 10.</td>
</tr>
<tr>
<td></td>
<td>Up Menu</td>
<td>Pressing this button will advance the menu selection to the next menu in the list. For example, if Menu 3 is currently loaded, pressing Next Menu will load Menu 4.</td>
</tr>
</tbody>
</table>
Menu Display

If you selected **Menu Display** from the first column, the **Value** column updates to list the following options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Navigate</td>
<td>Down Menu</td>
<td>Pressing this button will return the menu selection to the previous menu in the list. For example, if Menu 3 was loaded, pressing Down Menu will load Menu 2.</td>
</tr>
<tr>
<td></td>
<td>XPoint Layer</td>
<td>Pressing this button steps through the layers of a crosspoint</td>
</tr>
</tbody>
</table>

Salvo

If you selected **Salvo** from the first column, the **Value** column updates to list the salvos listed on the Salvo Names tab. Assigning a salvo to a button enables you to fire that specific salvo when the physical button on the hard panel is pressed.

Clear Key

If you selected **Clear Key** from the first column, the button is disabled.

Key Dialog

When you select a button, other than a Function button, on the simulated RCP-QE hard panel, the Key dialog displays for that button.

For More Information on...

- the default settings for the buttons, refer to the section “**Front Panel Overview**” on page 13.
The options in the Key dialog are the same as those found, except for the bottom toolbar in the dialog, in the Function Key Configuration dialog. These options are described in the section “Function Key Configuration Dialog” on page 85.

The following universal fields are also available in the Key dialog:

- **Auto-Advance** — select this check box to automatically select the next button on the panel. This function advances across the panel from left to right, top to bottom.
- **Maintain Selection** — select this check box if the Auto-Advance check box is selected and you wish to remain on the selected button.
- **Quick Find** — type a function into the box to rapidly access that function from the button list.

Configuration Tab

The RCP-QE Panel Config interface displays a series of tabs below the simulated panel area. This section outlines the options displayed when the Configuration tab is selected.

For More Information on...

- protects, refer to “Assigning a Protect Button” on page 65.
- crosspoints, refer to “Assigning a Crosspoint Button” on page 29.
All configuration items become active only after uploading by sending the configuration to the device.

Table 15.9 summarizes the options displayed in the **Configuration** tab.

### Table 15.9 Configuration Tab

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Link</td>
<td>Panel Link Address</td>
<td>#</td>
<td>Two or more remote control panels may be linked to form a larger physical panel. This is known as panel linking. Panels are linked when they have the same master address (as specified in the section “Changing the Device Details” on page 25) and different panel link addresses.</td>
</tr>
<tr>
<td>Breakaways</td>
<td>#</td>
<td>#</td>
<td>The list number of the breakaway (read-only)</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>The name assigned for the breakaway. The names are user configurable</td>
</tr>
<tr>
<td></td>
<td>level mask (1...32)</td>
<td>1-32</td>
<td>Click a router level to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• assign a level mask ( ) or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• de-select a level mask ( ).</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td></td>
<td>Click this button to clear all level masks for a given breakaway</td>
</tr>
<tr>
<td></td>
<td>Set</td>
<td></td>
<td>Click this button to apply all selected level masks for a given breakaway</td>
</tr>
<tr>
<td>Configuration</td>
<td>Breakaway Reset</td>
<td>Selected</td>
<td>Return to the default breakaway after every switch. The default is Breakaway 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td></td>
<td>Breakaway Warning Mode</td>
<td>Current</td>
<td>If there is a level mismatch compared to the current breakaway, a breakaway warning is shown when displaying the status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default</td>
<td>If there is a level mismatch compared to the default breakaway (Breakaway 1), a breakaway warning is shown when displaying the status</td>
</tr>
<tr>
<td></td>
<td>Panel Locked</td>
<td>Selected</td>
<td>Locks the panel buttons</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cleared</td>
<td>Unlocks the panel buttons</td>
</tr>
<tr>
<td></td>
<td>Machine Control Enabled</td>
<td>Selected</td>
<td>Uses machine control to provide reciprocal switching of RS-422 signals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td></td>
<td>Machine Control Level</td>
<td>#</td>
<td>Specify a router level for machine control</td>
</tr>
<tr>
<td></td>
<td>Virtual Routing Enabled</td>
<td>Selected</td>
<td>Enable virtual routings. Virtual routing requires an NK-VRC in an Ross NK series router system. Virtual routing must be enabled for the RCP-QE to function with an Ultrix router or Ultricore Central Controller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
</tbody>
</table>
### Menu Details Tab

The Menu Details tab enables you to specify:

- the maximum number of menus (button maps) the panel can access
- a hierarchy of the menus in the system
- the name for each menu
- a color for each menu
- the fallback mode for each menu

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comms Retry Delay Factor</td>
<td>#</td>
<td></td>
<td>Specifies a retry delay factor in milliseconds. Systems require different retry times depending on the transfer of requests and responses between modules. A value of 50ms is a recommended default.</td>
</tr>
<tr>
<td>Protect Mode</td>
<td>Block Other Panels</td>
<td></td>
<td>The protected destination and level(s) cannot be switched to another source by other remote control panels. The protected destination and level(s) can be switched to another source on the current remote control panel.</td>
</tr>
<tr>
<td></td>
<td>Block All Panels</td>
<td></td>
<td>The protected destination and level(s) cannot be switched to another source by the current remote control panel or other remote control panels.</td>
</tr>
<tr>
<td>Clear Protect(s)</td>
<td>Selected</td>
<td></td>
<td>Clears all protects from the panel.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td></td>
<td>Protects are applied to the panel</td>
</tr>
<tr>
<td>Return to Home Menu</td>
<td>Selected</td>
<td></td>
<td>Forces the panel to its home menu configuration</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td></td>
<td>Disables this feature</td>
</tr>
<tr>
<td>Load Factory Defaults</td>
<td>Selected</td>
<td></td>
<td>Loads the factory defaults of the panel</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td></td>
<td>Disables this feature</td>
</tr>
<tr>
<td>Category Mode</td>
<td>Exit Category Mode</td>
<td></td>
<td>Return to the Home menu (Menu 1) after any source/destination/level selection</td>
</tr>
<tr>
<td></td>
<td>Remain in Category Mode</td>
<td></td>
<td>Return to the Category main navigation menu after any source/destination/level selection</td>
</tr>
<tr>
<td>Category Color Mode</td>
<td>Override Display Options</td>
<td></td>
<td>Apply default Category Mode LCD color scheme</td>
</tr>
<tr>
<td></td>
<td>Use Display Options</td>
<td></td>
<td>Apply the display settings specified in the Panel Config &gt; Configuration &gt; Category Mode menus</td>
</tr>
<tr>
<td>Category Level Behavior</td>
<td>Set Level</td>
<td></td>
<td>Single level selection mode</td>
</tr>
<tr>
<td></td>
<td>Toggle Level</td>
<td></td>
<td>Multiple level selection mode</td>
</tr>
<tr>
<td>Alarms (read-only)</td>
<td>Protect</td>
<td>No Protect (Green)</td>
<td>Indicates that there is no crosspoint protect enabled on the panel</td>
</tr>
<tr>
<td></td>
<td>Protect(s) (Yellow)</td>
<td></td>
<td>Indicates that a crosspoint protect is enabled on the panel</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 15.9 Configuration Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Area</strong></td>
</tr>
<tr>
<td>Configuration</td>
</tr>
<tr>
<td>Protect Mode</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Clear Protect(s)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Return to Home Menu</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Load Factory Defaults</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Category Mode</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Category Color Mode</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Category Level Behavior</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Alarms (read-only)</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Table 15.10 summarizes the options displayed in the **Menu Details** tab.

**Table 15.10 Menu Details Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Menus</td>
<td>#</td>
<td>Specify a number of menus to use for the panel</td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td>Updates the amount of menus used for the panel</td>
</tr>
<tr>
<td>Menu Number (read-only)</td>
<td>#</td>
<td>Displays the list order number of the menu</td>
</tr>
<tr>
<td>Menu Name</td>
<td>&lt;text&gt;</td>
<td>Enter or edit a name for the selected menu</td>
</tr>
<tr>
<td>Fallback Mode</td>
<td>Fallback Off</td>
<td>After a button in the menu is pressed, the RCP-QE remains on the menu the panel is currently on</td>
</tr>
<tr>
<td>First Menu</td>
<td></td>
<td>After a button in the menu is pressed, the RCP-QE returns to Menu Number 1</td>
</tr>
<tr>
<td>Previous Menu</td>
<td></td>
<td>After a button in the menu is pressed, the RCP-QE returns to the menu that was active prior to the current menu</td>
</tr>
<tr>
<td>Specified Menu</td>
<td></td>
<td>After a button in the menu is pressed, the RCP-QE returns to the menu specified in the Fallback Menu column</td>
</tr>
<tr>
<td>Fallback Menu</td>
<td></td>
<td>If using Specified Menu as the fallback mode, click inside the table cell to enter a menu number to return to after a button is pressed</td>
</tr>
<tr>
<td>Fallback Menu #</td>
<td></td>
<td>Specifies the Menu Number the Fallback Mode will use</td>
</tr>
<tr>
<td>Menu Color</td>
<td></td>
<td>Sets the button color for the menu button</td>
</tr>
</tbody>
</table>

**Output/Input Assigns Tab**

If the RCP-QE is configured to connect to an Ultrix router or Ultricore Central Controller, the output and input assignments are managed from those devices. Any editing on the RCP-QE tabs will be overwritten. You can use the Database to RCP button on the Network tab in the Ultrix/Ulricore interfaces to load input/output/level assignments to the RCP-QE panel.
Table 15.11 summarizes the options displayed in the Output Assigns and Input Assigns tabs.

Table 15.11 Output/Input Assigns Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of outputs/inputs</td>
<td>#</td>
<td>Specifies a number of outputs/inputs. The number must be changed in increments of eight.</td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td>Updates the output/input assigns</td>
</tr>
<tr>
<td>Copy to Input/Output Assigns</td>
<td></td>
<td>Transfers the number of outputs/inputs to the other assigns tab. The labels are also imported.</td>
</tr>
<tr>
<td>Import Global Labels</td>
<td></td>
<td>Imports global labels (a file create and managed by DashBoard) for the input/output labels</td>
</tr>
<tr>
<td>Output/Input Range</td>
<td>#</td>
<td>Specifies the range of outputs/inputs to view in the Output/Input Assigns. The Assigns tab will only display the ranges in blocks of 120 outputs/inputs at a time, with each block selectable in the list.</td>
</tr>
<tr>
<td>Out/In (read-only)</td>
<td>#</td>
<td>Displays the output/input number</td>
</tr>
<tr>
<td>Label</td>
<td></td>
<td>Edit or enter a name for the output/input. If you have configured global labels, the labels can also be filled in by clicking the Import Global Labels button.</td>
</tr>
</tbody>
</table>

Display Options Tab

The Display Options tab enables you to define the display options for a Function or Mode when assigned to a button. This includes:

- the color of the physical button when it is not selected by a user
- the color of the physical button when it is selected by a user
Table 15.12 summarizes the options displayed in the Display Options tab.

<table>
<thead>
<tr>
<th>Area</th>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Options</td>
<td>Mode #</td>
<td>&lt;text&gt;</td>
<td>Specify the type of button function</td>
</tr>
<tr>
<td>Default Color</td>
<td></td>
<td></td>
<td>Specify the button color when it is not selected or active</td>
</tr>
<tr>
<td>Invert Default</td>
<td>Selected</td>
<td></td>
<td>Inverts the text on the button when it is not selected or not active</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td></td>
<td>Enables this feature</td>
</tr>
<tr>
<td>Selected Color</td>
<td></td>
<td></td>
<td>Specify a color for the button when it is selected or active</td>
</tr>
<tr>
<td>Invert Selected</td>
<td>Selected</td>
<td></td>
<td>Inverts the text on the button when it is selected or active</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td></td>
<td>Enables this feature</td>
</tr>
</tbody>
</table>

Macro Names Tab

The Macro Names tab enables you to assign a new label, to be used only on this hard panel, to the macros available in the router matrix.
Table 15.13 summarizes the options displayed in the Macro Names tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># (read-only)</td>
<td>#</td>
<td>Displays the macro number</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>Specifies a unique identifier for the macro</td>
</tr>
</tbody>
</table>

Macro Events Tab

The Macro Events tab enables you to configure the macros the hard panel will use.

Table 15.14 summarizes the options displayed in the Macro Events tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro # (read-only)</td>
<td>#</td>
<td>Specifies the macro number</td>
</tr>
<tr>
<td>Num. Rows</td>
<td>#</td>
<td>Specifies the number of events to add to the macro</td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td>Updates the macro with the number of rows entered in the Num. Rows field</td>
</tr>
<tr>
<td>Event (read-only)</td>
<td>#</td>
<td>Displays the macro event number. Triggering the macro will trigger events in this order.</td>
</tr>
<tr>
<td>Function</td>
<td>Switch</td>
<td>Performs a standard crosspoint switch</td>
</tr>
<tr>
<td></td>
<td>Macro</td>
<td>Performs a macro within the executed macro</td>
</tr>
<tr>
<td></td>
<td>Protect</td>
<td>Creates a protect condition on the destination of the selected crosspoint</td>
</tr>
<tr>
<td>Output</td>
<td>#</td>
<td>Specifies the destination output</td>
</tr>
<tr>
<td>Input</td>
<td>#</td>
<td>Specifies the source input</td>
</tr>
<tr>
<td>Level Mask (1...32)</td>
<td>#</td>
<td>Specifies the level mask(s) for the device affected by the macro</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td>Clear the level mask(s)</td>
</tr>
<tr>
<td>Set</td>
<td></td>
<td>Set the level mask(s)</td>
</tr>
</tbody>
</table>
Salvo Names Tab

* Only applicable when the routing system includes an Ultrix router or Ultricore Central Controller.

The **Salvo Names** tab enables you to assign a new label, to be used only on this hard panel, to the salvos available in the router database.

![Figure 15.12 Panel Config — Salvo Names Tab](image)

Table 15.15 summarizes the options displayed in the **Salvo Names** tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvo # (read-only)</td>
<td><code>#</code></td>
<td>Displays the list order number of the salvo</td>
</tr>
<tr>
<td>Name (read-only)</td>
<td><code>&lt;text&gt;</code></td>
<td>Name of the salvo as defined by the connected Ultrix router or Ultricore Central Controller</td>
</tr>
</tbody>
</table>

Level Names Tab

* Only applicable when the routing system includes an Ultrix router or Ultricore Central Controller.

The **Level Names** tab enables you to assign a new label, to be used only on this RCP-QE, to the levels available in the router matrix. You can also choose to enable or disable individual levels for this panel.

![Figure 15.13 Panel Config — Level Names Tab](image)
Table 15.16 summarizes the options displayed in the Level Names tab.

### Table 15.16  Level Names Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># (read only)</td>
<td>#</td>
<td>Displays the list order number of the level name entry</td>
</tr>
<tr>
<td>Name (read-only)</td>
<td>text</td>
<td>Displays the name of the Level as defined in connected Ultrix router or Ultricore Central Controller</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Enable/disable this level in Category Index mode</td>
</tr>
</tbody>
</table>

**Destination / Source Label Access**

This pair of tabs enable destinations or sources to be enabled or disabled for button assignment.

![Panel Config — Dest Label Access Tab](image)

Table 15.17 summarizes the options displayed in the Destination Label Access and Source Label Access tabs.

### Table 15.17  Destination/Source Label Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>text</td>
<td>Performs a dynamic search on the listed labels</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td>Clears the check box for the selected label(s)</td>
</tr>
<tr>
<td>Set&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
<td>Sets the check box for the selected label(s)</td>
</tr>
<tr>
<td># (read only)</td>
<td>#</td>
<td>Displays the list order number of the level name entry</td>
</tr>
<tr>
<td>Label (read-only)</td>
<td>text</td>
<td>Displays the name of the Label as defined in connected Ultricore control system database</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Enable/disable this destination or source in Category Index mode</td>
</tr>
</tbody>
</table>

<sup>a</sup>  Multiple label selections may be made with standard keyboard hot-keys (e.g. Shift+click, Ctrl+click).
Bottom Toolbar

The bottom toolbar provides the following buttons:

- **Refresh** — click this button to revert to the configuration previously sent to the RCP-QE. The RCP-QE Connection Editor will display the last settings that were sent to the RCP-QE via the Send Configuration button.

- **Send Firmware** — this button is not implemented.

- **Send Configuration** — click this button to upload the settings to the RCP-QE. All configuration items become active only after uploading. Refer to the section “Send Configuration Dialog” below for details.

- **Reboot** — click this button to reboot the RCP-QE. This function does not clear the RCP-QE settings.

- **Close** — click this button to close the RCP-QE Connection Editor in DashBoard.

Send Configuration Dialog

The **Send Configuration** dialog is used to apply the changes made in DashBoard to the hard panel. The dialog is divided into two areas:

- a column that lists the tabs that have unsent parameters
- the Select Devices list that enables you to specify which panels to send the new configuration to.

This dialog is displayed when the **Send Configuration** button is clicked on the Panel Config interface.

![Figure 15.15 Example of a Send Configuration Dialog](image)

**Table 15.18** lists the tab check boxes available in the **Send Configuration** dialog.

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Pages</td>
<td>Selecting this selects every tab, including the Function and Key button definitions to send to the device.</td>
</tr>
<tr>
<td>Home</td>
<td>The information contained in the <strong>Device Details</strong> frame and the <strong>Configuration</strong> tab.</td>
</tr>
<tr>
<td>Key Definitions</td>
<td>The information defining how the SRC/DEST buttons have been assigned.</td>
</tr>
<tr>
<td>Menu Details</td>
<td>The information contained on the <strong>Menu Details</strong> tab.</td>
</tr>
<tr>
<td>Output Assign</td>
<td>The information contained on the <strong>Output Assigns</strong> tab.</td>
</tr>
<tr>
<td>Input Assign</td>
<td>The information contained on the <strong>Input Assigns</strong> tab.</td>
</tr>
<tr>
<td>Display Options</td>
<td>The information contained on the <strong>Display Options</strong> tab.</td>
</tr>
<tr>
<td>Macro Names</td>
<td>The information contained on the <strong>Macro Names</strong> tab.</td>
</tr>
<tr>
<td>Macro Events</td>
<td>The information contained on the <strong>Macro Events</strong> tab.</td>
</tr>
<tr>
<td>Salvo Names</td>
<td>The information contained on the <strong>Salvo Names</strong> tab.</td>
</tr>
<tr>
<td>Level Names</td>
<td>The information contained on the <strong>Level Names</strong> tab.</td>
</tr>
</tbody>
</table>
Select Devices Area

The Select Devices area includes the following columns:

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>The information contained in the combined pool of input and output labels.</td>
</tr>
<tr>
<td>Function</td>
<td>The information defining how the Function buttons have been assigned</td>
</tr>
<tr>
<td>Definitions</td>
<td></td>
</tr>
</tbody>
</table>

Table 15.18  Page Descriptions

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name assigned to the device.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Displays the serial number of the device.</td>
</tr>
<tr>
<td>Version</td>
<td>Indicates the software version the device is currently running.</td>
</tr>
<tr>
<td>Connected to IPS</td>
<td>Indicates if the device is communicating with the RCP-QE via a specific NK-IPS</td>
</tr>
<tr>
<td>SmartPaste</td>
<td>The check box is automatically selected when electing to send the current configuration to devices other than being currently edited. Only the Panel Configuration options (not panel details), are transferred to other devices of the same type.</td>
</tr>
</tbody>
</table>
Panel Hexadecimal to Router Level Conversion

The router level is represented by eight hexadecimal characters. For each hexadecimal character, read the corresponding binary representation across the table.

For each ‘1’ that appears in the binary representation, drop down to the Level row to read the actual router level included in the mask. For example, 0AB50221 represents levels 28, 26, 24, 22, 21, 19, 17, 10, 6, and 1.

<table>
<thead>
<tr>
<th>Hexadecimal</th>
<th>1st character</th>
<th>2nd character</th>
<th>3rd character</th>
<th>4th character</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>A</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>F</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Level</th>
<th>32</th>
<th>31</th>
<th>30</th>
<th>29</th>
<th>28</th>
<th>27</th>
<th>26</th>
<th>25</th>
<th>24</th>
<th>23</th>
<th>22</th>
<th>21</th>
<th>20</th>
<th>19</th>
<th>18</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>5th character</td>
<td>6th character</td>
<td>7th character</td>
<td>8th character</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Level | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9  | 8  | 7  | 6  | 5  | 4  | 3  | 2  | 1  |

RCP-QE18 and RCP-QE36 User Guide (v4.0)
Glossary

The following terms are used throughout this guide:

**Breakaway** — an act of performing a switch on only some of the signals grouped together under one label.

**Connection Point** — setting to define a communication connection between RCP-QE and a device in the routing system.

**Crosspoint** — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires one crosspoint.

**Destination** — a logical label representing an output or group of outputs from the routing system.

**IP Address** — a setting that defines the Internet protocol address of a device within a network.

**Label** — text that is used by control displays to identify a signal as an input or output.

**Level (Layer)** — refers to a section of a routing system. For example, a video router would be one level and an audio router would be a second level.

**Lock** — a function preventing any control device from changing the source of a specific destination.

**Logical (Virtual) Label** — a name for a group of routing system inputs or outputs.

**Logical (Virtual) Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).

**Macro** — a recorded sequence of Remote Control Panel operations (local to the panel).

**Map** — a table that defines the allocation of logical names (labels) to routing system physical input and output sockets.

**Matrix** — the part of the routing system that performs the actual signal switching tasks.

**Partition** — matrices may be partitioned to behave as smaller independent matrices.

**Protect** — a function preventing other control devices from changing the source of a specific destination.

**RCP-QE** — refers to the RCP-QE18 and RCP-QE36 unless otherwise noted.

**Remote Control Panel (RCP)** — a physical hardware panel of buttons that is used to control the routing system.

**Salvo** — a system wide sequence of matrix control operations and crosspoint actions. Salvos are only available via Ultricore control systems.

**Source** — a logical label representing an input or group of inputs to the routing system.

**T-Bus** — the Ross Video proprietary routing communication method via a defined physical interface.

**Tied (Audio Follow Video)** — the default breakaway name referring to all routing system levels.

**Virtual Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).